Copyright and Trademark

Copyright © 2003, 2004, 2005, 2006, 2007, 2008, 2009, 2014 Entertainment Partners or its subsidiaries or affiliates. All rights reserved. Entertainment Partners, the Entertainment Partners logo, EP Entertainment Partners and Movie Magic Budgeting are trademarks of Entertainment Partners, or its subsidiaries or affiliated companies. Other product and brand names may be trademarks or registered trademarks of their respective Owners.

Disclaimer and Limitation of Liability

Entertainment Partners and its subsidiaries and affiliates assume no responsibility for any damage or loss resulting from the use of this Manual. Entertainment Partners assumes no responsibility or liability for any errors or inaccuracies that may be displayed in this Manual.

Entertainment Partners and its subsidiaries and affiliates assume no responsibility for any loss or claims by third parties which may arise through use of this software. Entertainment Partners and its subsidiaries and affiliates assume no responsibility for any damage or loss caused by deletion of data as a result of malfunction, dead battery or power loss or repairs. Be sure to make backup copies of all important data on other media to protect against data loss.

IMPORTANT: Please read the Entertainment Partners End-User License Agreement accompanying the software program(s). Using any part of the software indicates that you accept the term of the End-User License Agreement.

Windows® and Microsoft® are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or other countries.

Mac®, Macintosh®, and Apple® are registered trademarks of Apple Computer, Inc.
Movie Magic Budgeting Manual

Table of Contents

Movie Magic Budgeting 7 ................................................................. 1
  Introduction .................................................................................. 1
  Four Major Budgeting Steps ......................................................... 1

Chapter 1: Getting Started ............................................................... 2
  Section 1: Navigation ..................................................................... 2
    The Movie Magic Budgeting 7 Toolbar ........................................... 2
    WorkSheet Navigation ................................................................. 3
    Hide WorkSheet Options ............................................................. 3
    Goto Menu .................................................................................. 4
    Goto Account ............................................................................. 4
    Window Navigation ..................................................................... 5
    Arrange ..................................................................................... 5
    Actions ...................................................................................... 5
    Tab Navigation ........................................................................... 8

Section 2: Selecting and Highlighting ................................................ 8
  Tabbing ....................................................................................... 8
  Single-Clicking .......................................................................... 8
  Double-Clicking and Triple-Clicking ............................................. 8
  Selecting Single Lines ................................................................ 9
  Selecting More than One Line .................................................... 9

Section 3: Shortcut Keys for PC and Mac Users ................................. 9
  Keystrokes & Function Keys ......................................................... 9

Section 4: Starting a Budget ............................................................. 13
  Starting a Budget from a Template ................................................ 13
  Starting a Budget from Scratch ..................................................... 13
  Budgets may also be created from scratch .................................. 13
  Opening a Budget ....................................................................... 14
  Opening a Recently Accessed Budget ......................................... 15
  Accessing a Classic Movie Magic ................................................. 15
  Opening a Classic Movie Magic Budget ...................................... 15
  Creating Movie Magic Budgeting 7 files from Classic MMB files .... 17

Section 5: Saving ............................................................................ 18
  Save Reminder ............................................................................ 18
  Save ............................................................................................ 19
  Save All ...................................................................................... 19
  Save As ...................................................................................... 19
  Saving a Budget as a Template ................................................... 20

Section 6: Exporting Budget Files ..................................................... 21
  Exporting to Classic Movie Magic 5.x .......................................... 22
  Other Export .............................................................................. 23

Chapter 2: Budget Setup .................................................................. 25
  Section 1: Budget Preferences ...................................................... 25
Chapter 4: Accounts Level ................................................................. 60

Section 1: Accessing the Account Level ........................................... 60
Section 2: Entering Account Level Information ............................... 60

Chapter 5: Globals ........................................................................... 61

Section 1: Setting Up Globals .......................................................... 61
Globals Toolbar ............................................................................. 61
Exiting the Setup Globals Table ....................................................... 62
Global Groups .............................................................................. 62
Adding a Global Group .................................................................. 63
Adding Globals to a Global Group ................................................... 63
How to Add a Global to a Global Group .......................................... 63
Viewing Multiple Global Groups ................................................... 65
Inserting a New Global to an Existing List of Globals .................... 66
Moving Globals ............................................................................ 67
Move Globals to a Different Position within a Globals List .............. 67
Move a Global Down within a Globals List ..................................... 67
Move a Global Up within aGlobals List ....................................... 68
Move a Global from One Global Group to Another ......................... 69
SortingGlobals Alphabetically within a Global Group .................... 70
Sorting Other Globals Columns .................................................... 70
Sorting Global Groups ................................................................. 72
Copying Globals ........................................................................ 72
Merge Global Groups .................................................................. 73
Global Display ............................................................................ 75
Deleting a Global ........................................................................ 75

Chapter 6: Fringes ........................................................................... 77

Section 1: Creating Fringes .............................................................. 77
Creating a Percentage Fringe ......................................................... 77
Totals ............................................................................................ 78
Editing Fringes ............................................................................ 78

Section 2: Applying Fringes .............................................................. 79
Percentage Fringe ........................................................................ 79
Flat Rate Fringe .......................................................................... 79
Removing Fringes ........................................................................ 80
Setting a Fringe Range .................................................................. 80
Setting Individual (Removing) Fringe Ranges .................................. 81
View/Apply Fringes Window Buttons/Selections .............................. 82
Fringe Range ............................................................................. 82
Displaying Fringes in the Budget ................................................... 83

Chapter 7: Groups ........................................................................... 84

Section 1: Setup Groups Window .................................................... 84
Setting Up Groups ......................................................................... 84
Adding New Groups ..................................................................... 85
Deleting a Group ......................................................................... 85
Budget Calculation ...................................................................... 86
Default status for non-grouped detail lines .................................... 86
Status if there is a Group status conflict ....................................... 86
Fringe amounts in Group Totals .................................................... 86
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 8: Details Level</td>
<td>Accessing the Details Level</td>
<td>89</td>
</tr>
<tr>
<td></td>
<td>Goto Account</td>
<td>89</td>
</tr>
<tr>
<td>Section 2: Entering Details Level Information</td>
<td>Formula Maker</td>
<td>90</td>
</tr>
<tr>
<td></td>
<td>Formula Recall</td>
<td>91</td>
</tr>
<tr>
<td></td>
<td>Other Formula Maker Buttons</td>
<td>92</td>
</tr>
<tr>
<td>Section 3: Dedicated Detail Columns (Toggle icons)</td>
<td>93</td>
<td></td>
</tr>
<tr>
<td>Section 4: Optional Detail Columns</td>
<td>93</td>
<td></td>
</tr>
<tr>
<td>Section 5: Note</td>
<td>94</td>
<td></td>
</tr>
<tr>
<td>Chapter 9: 4th Level</td>
<td>Create a New 4th Level</td>
<td>95</td>
</tr>
<tr>
<td></td>
<td>Access the 4th Level</td>
<td>96</td>
</tr>
<tr>
<td></td>
<td>Using 4th Level</td>
<td>97</td>
</tr>
<tr>
<td></td>
<td>Autosum</td>
<td>97</td>
</tr>
<tr>
<td></td>
<td>Link 4th Level Data with Details Level</td>
<td>98</td>
</tr>
<tr>
<td>Section 4: Copying and Pasting Text between the 4th Level and Details</td>
<td>Copy and Paste a Range of Cells from the Details Level to the 4th Level</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>Copy and Paste Text from the 4th Level to the Details Level</td>
<td>101</td>
</tr>
<tr>
<td>Section 5: Formatting the 4th Level</td>
<td>Formatting Options</td>
<td>102</td>
</tr>
<tr>
<td></td>
<td>103</td>
<td></td>
</tr>
<tr>
<td>Chapter 10: Shortcuts</td>
<td>Creating a Shortcut</td>
<td>106</td>
</tr>
<tr>
<td></td>
<td>Create Shortcuts from Scratch</td>
<td>108</td>
</tr>
<tr>
<td></td>
<td>Applying Shortcuts</td>
<td>109</td>
</tr>
<tr>
<td></td>
<td>Deleting a Shortcut</td>
<td>109</td>
</tr>
<tr>
<td>Section 5: Shortcuts Report</td>
<td>Print Preview</td>
<td>110</td>
</tr>
<tr>
<td></td>
<td>Print</td>
<td>110</td>
</tr>
<tr>
<td></td>
<td>Converting to PDF</td>
<td>110</td>
</tr>
<tr>
<td>Chapter 11: Recalculate</td>
<td>111</td>
<td></td>
</tr>
<tr>
<td>Chapter 12: Library</td>
<td>Library Functions</td>
<td>112</td>
</tr>
<tr>
<td></td>
<td>Open Library Manager</td>
<td>112</td>
</tr>
<tr>
<td></td>
<td>Open an existing Library</td>
<td>113</td>
</tr>
<tr>
<td></td>
<td>Extract Data</td>
<td>113</td>
</tr>
<tr>
<td></td>
<td>Insert Data</td>
<td>113</td>
</tr>
</tbody>
</table>
Chapter 13: Budget Comparison ........................................................................... 115
  Budget Comparison Report Buttons ................................................................ 116
  Comparing to Vista Cost Reports .................................................................... 117
Chapter 14: Copy and Paste Between Two Budgets ............................................. 118
  Section 1: Copy and Paste Between Budgets at the Topsheet Level ............... 118
  Section 2: Copy and Paste Between Budgets at the Accounts Level .............. 120
  Section 3: Copy and Paste between budgets at the Details Level ................. 121
Chapter 15: Create a Sub Budget ................................................................. 122
  Section 1: Include Notes ............................................................................. 122
  Section 2: Include Fringes ........................................................................... 122
Chapter 16: Find Tool ..................................................................................... 125
  Section 1: Main Functions ........................................................................... 125
    Access Find ............................................................................................... 125
    Conducting a Text/Numeric Find ............................................................ 125
    Conducting a Fringe Find ......................................................................... 127
    Find Next .................................................................................................. 127
  Section 2: Find and Replace ......................................................................... 128
    Access Find and Replace .......................................................................... 128
    Conducting a Text/Numeric Replace ........................................................ 128
Chapter 17: Print Setup .................................................................................... 130
  Access Print Setup ....................................................................................... 130
  Section 1: Select Report(s) ......................................................................... 130
  Section 2: Select Additional Column(s) to Print ........................................ 131
  Section 3: Budget Data Option ..................................................................... 131
    Display Currency by Value ....................................................................... 131
    Suppress Excluded Group ........................................................................ 131
    Print Fields Equal to 1 or 0 ..................................................................... 131
  Section 4: Print Account Option .................................................................. 132
    All ........................................................................................................... 132
    Account Range ......................................................................................... 132
    Account Selection ..................................................................................... 133
  Section 5: Format Option ............................................................................ 133
    Page Break ............................................................................................... 134
    Select a Page Break ................................................................................ 134
  Section 6: Page Setup ................................................................................ 134
  Section 7: Edit Header/Footer ...................................................................... 135
    Layout ....................................................................................................... 135
    Setup Text ............................................................................................... 135
    Topsheet Only ......................................................................................... 136
Section 5: View/Exclude Contractual Charges ................................................................. 153
Section 6: View/Apply Credit Adjustments ................................................................. 153
Index ................................................................................................................................ 154
Movie Magic Budgeting 7

Introduction

Budgeting for the 21st Century.

Movie Magic Budgeting 7 allows the user to create simple to complex film and television production budgets with ease and accuracy. Innovative tools and features exclusive to Movie Magic Budgeting 7 include the Applied Credits, dedicated Sets, Currency, Groups and Locations columns, Budget Comparison Reports, Sub Budgets and an intuitive Tab Navigator.

As part of the EP Global Production Office, this software brings a project steps closer to becoming a reality.

Four Major Budgeting Steps

1. Create a broad category of accounts in the Topsheet.
2. Create accounts in the Accounts Level.
3. Set up tables:
   - Units
   - Globals
   - Groups
   - Fringes
   - Locations
   - Sets
   - Currencies
4. Create details, applying the Fringes, Globals, Groups, and other desired properties (e.g. Sets) as necessary.
Chapter 1: Getting Started

Before beginning budgeting, take a moment to become familiar with some of the basics of Movie Magic Budgeting 7. This first chapter will show frequently used toolbars, the steps to creating new budgets and procedures to properly save them.

Section 1: Navigation

Movie Magic Budgeting 7 offers intuitive navigation with its toolbars, tabs, and menus.

The Movie Magic Budgeting 7 Toolbar

Movie Magic Budgeting’s main tools are easily accessible from the toolbar.

- **Open File**: Opens the selected budget
- **Save All Budgets**: Saves all opened budgets
- **Print Active Budget**: Prints only active budgets
- **Print Preview**: Creates an on-screen preview of an actual printed budget
- **PDF**: Converts an active file to a PDF
- **Applied Credit**: Opens a new instance of an Applied Credit window (Topsheet only)
- **Fringe**: Opens the View/Apply Fringes window
- **Groups**: Opens the View/Apply Groups window
- **Formula Maker**: Opens the Formula Maker window
- **Globals**: Opens the Setup Globals window
Navigation Ball:
1. Press **Arrow Up** to move up one level
2. Press **Arrow Down** to move down one level
3. Press **Left Arrow** to move to previous Account or Category
4. Press **Right Arrow** to move to next Account or Category

**Topsheet**: Brings up the Topsheet level of a budget

**Accounts Level**: Brings up the Accounts Level of a budget

**Details Level**: Brings up the Details Level of a budget

**4th Level**: Opens a hidden 4th Level sheet

**Search**: Search by Account number

Atop the Details Level window is the Details Level toolbar, which comprises six dedicated column buttons visible on the left. Each button is a toggle and shows or hides its corresponding column in the Details Level when clicked.

```
AGG FRIN GRP LOC SET CUR
```

**Agg**: Aggregate Fringe percentage

**Frin**: Applied Fringe list

**Grp**: Groups

**Loc**: Location

**Set**: Set

**Cur**: Currency

**WorkSheet Navigation**

The WorkSheet options from the menu bar provide access to the 4th Level functions and options. The 4th Level functionality is detailed further in the **4th Level** section.

**Hide WorkSheet Options**

These options only apply to the 4th Level worksheets that are currently open on the budgeting desktop.
• **Hide Active Sheet**: Hides the sheet currently being worked on (usually the sheet that is on top)

• **Hide All But Current**: Hides all of the sheets except the one being worked on currently

• **Hide All**: Hides all of the sheets that are open on a budgeting desktop except for Topsheet; hide does not apply to Topsheet

**Goto Menu**

The **Goto Menu** features the same navigational tools that are found on the Movie Magic Budgeting 7 toolbar.

To use the **Goto Menu**:

1. Go to **Goto** and select where to go from the menu; this will immediately bring up the selected destination.

**Goto Account**

1. Select the Goto **Account** tool.

The Goto Account window will be displayed.

2. Enter the Account number to go to.
3. Click **OK**.

This action will bring up that Account.
Window Navigation

Move among numerous open windows by using the Window menu. This menu lists all of the currently opened windows on a budgeting desktop. The budgeting desktop is divided into two parts: Arrange Budgets and Arrange Sheets.

- **Arrange Budgets**: Contains windows for all budgets opened
- **Arrange Sheets**: Contains windows within each open budget

Arrange Budgets represents the program window in which the budgets are arranged. Arrange Sheets represents the window in which budget-specific windows are arranged, such as the budget’s Accounts Level or Details Level windows.

Go to Window and select which window to navigate to.

Arrange

All open windows can be arranged on any desktop. Activate the window to be arranged by clicking in or on it.

To arrange open budgets:

1. Go to Window and select Arrange.

   ![Arrange Window](image)

   The Arrange Desktop window will be displayed.

2. Select the desktop to be arranged, either Budgets or Sheets.
3. Select an action that describes how the budget can best be arranged for individual needs.

Actions

- **Tile Arrangement**: Arranges the windows on a desktop in evenly spaced windows without overlapping
**Horizontal Arrangement**: Arranges windows horizontally where each frame occupies the entire width of the desktop.

**Vertical Arrangement**: Arranges the windows vertically where each frame occupies the full height of the desktop.
• **Cascade**: Overlaps all the budgets on a budget desktop, with each window title bar showing for access.

![Sidebar](image)

**Note**: All vertical arrangements require column resizing to view the scrollbars located to the right of each window.

• **Iconize**: Iconize turns all open budgets into small icons for identification and access; icons may be repositioned by clicking and dragging on the left tab of each icon. Double-click on an icon to revert that specific window to its previous arrangement.

![Sidebar](image)

• **Arrange Icon**: Returns icons to original default icon position

• **De-Iconize**: Reverts budgets from icons to previous arrangement

• **Maximize All**: Enlarges all budget windows to maximum size on a budget desktop with the active budget in front and inactive budgets hidden behind
Tab Navigation

Each budget window that is open on the main desktop includes a set of tabs that navigate to each budget-specific window open for that budget. The tabs are located at the bottom of each sub desktop.

**Note:** Tab Navigation will not function properly if the **Single Document** option is selected in the **Options** menu. With this option selected, only one budget window can be open at a time. Only one tab will be displayed at a time.

---

Section 2: Selecting and Highlighting

**Note:** The shaded fields of the budget are non-editable areas. The shaded fields contain information, such as labels or calculations, that Movie Magic Budgeting 7 has made based on calculated budget data.

**Tabbing**

The **Tab** key provides a method for navigating through fields within a budget level. Hit the Tab key to the next field. Use **Shift-Tab** to return to the previous field.

**Single-Clicking**

- Single-clicking in a field will bring up that field, allowing the user to type over existing text.

**Double-Clicking and Triple-Clicking**

- Double-clicking on the row number of a Category or Account name will initiate a move down one level.
- Double-clicking on a Detail line initiates a return to the Topsheet.
• Double-clicking in a field will allow for editing text.
• Double-clicking from within the same field will highlight the word the mouse is directly over, allowing for that word to be typed over.
• Triple-clicking from within the same field will highlight the entire line text, allowing the text to be typed over.

Selecting Single Lines
• Click the row number of the line to be selected. The line will be highlighted.

Selecting More than One Line
To select more than one budget line at once:
• Click and drag the cursor either up or down over the line numbers, highlighting the lines the cursor moves over.
• Hold down the Control key and click the row number of each line to be selected. As with the click-and-drag method, this allows for selecting and highlighting individual lines instead of an entire block of lines.

Section 3: Shortcut Keys for PC and Mac Users

Keystrokes & Function Keys

<table>
<thead>
<tr>
<th>Function</th>
<th>MMB 7-PC/Mac Shortcut Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>File: New Budget</td>
<td>CTRL+N / CMD + N</td>
</tr>
<tr>
<td>File: Create Blank Budget</td>
<td>CTRL+SHIFT+N / CMD + SHIFT + N</td>
</tr>
<tr>
<td>File: Make Template</td>
<td>CTRL+SHIFT+T / CMD + SHIFT + T</td>
</tr>
<tr>
<td>File: Open File</td>
<td>CTRL+O / CMD + 0</td>
</tr>
<tr>
<td>File: Reopen (most recent file)</td>
<td>F12</td>
</tr>
<tr>
<td>File: Save</td>
<td>CTRL+S / CMD + S</td>
</tr>
<tr>
<td>File: Save As</td>
<td>CTRL+SHIFT+S / CMD + SHIFT + S</td>
</tr>
<tr>
<td>File: Close Active Window</td>
<td>CTRL+W / CMD + W</td>
</tr>
<tr>
<td>File: Close Active Budget</td>
<td>CTRL+SHIFT+W / CMD + SHIFT + W</td>
</tr>
<tr>
<td>File: Print Setup</td>
<td>CTRL+P / CMD + P</td>
</tr>
<tr>
<td>File: Print Preview</td>
<td>CTRL+SHIFT+V / CMD + SHIFT + V</td>
</tr>
<tr>
<td>File: Print</td>
<td>CTRL+SHIFT+P / CMD + SHIFT + P</td>
</tr>
<tr>
<td>File: Exit</td>
<td>CTRL+Q / CMD + Q</td>
</tr>
</tbody>
</table>

Edit: Undo                       | CTRL+Z / CMD + Z                              |
Edit: Redo                       | CTRL+SHIFT+Y / CMD + SHIFT                    |
Edit: Cut                        | CTRL+X / CMD + X                              |
<table>
<thead>
<tr>
<th>Edit: Copy</th>
<th>CTRL+C / CMD + C</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit: Paste</td>
<td>CTRL+V / CMD + V</td>
</tr>
<tr>
<td>Edit: Insert Row</td>
<td>CTRL+I / CMD + I</td>
</tr>
<tr>
<td>Edit: Insert Production Total</td>
<td>CTRL+B / CMD + B</td>
</tr>
<tr>
<td>Edit: Insert Contractual Charge</td>
<td>CTRL+/ (i) CMD +/</td>
</tr>
<tr>
<td>Edit: Insert Subtotal Adjustment</td>
<td>CTRL+ -(Minus) / CMD + -(Minus)</td>
</tr>
<tr>
<td>Edit: Insert Subtotal</td>
<td>CTRL+ =(Equals) / CMD + = (Equals)</td>
</tr>
<tr>
<td>Edit: Delete Row</td>
<td></td>
</tr>
<tr>
<td>Edit: Clear</td>
<td>CTRL+(Delete) / CMD (Delete)</td>
</tr>
<tr>
<td>Edit: Select All</td>
<td>CTRL+A / CMD + A</td>
</tr>
<tr>
<td></td>
<td>SHIFT+F4</td>
</tr>
<tr>
<td>Edit: Select Row</td>
<td>CTRL+<code>(Back Quote) / CMD + </code>(Back Quote)</td>
</tr>
<tr>
<td>Edit: Find</td>
<td>CTRL+F / CMD + F</td>
</tr>
<tr>
<td></td>
<td>SHIFT+F10</td>
</tr>
<tr>
<td>Edit: Find Next</td>
<td>CTRL+SHIFT+F / CMD + SHIFT + F</td>
</tr>
<tr>
<td>Edit: Replace</td>
<td>CTRL+H / CMD + H</td>
</tr>
</tbody>
</table>

| Tools: View/Apply Fringes | CTRL+1 / CMD + 1 |
|                          | F1               |
|                          | SHIFT+F1         |
| Tools: View/Apply Groups | CTRL+2 / CMD + 2 |
|                          | F2               |
|                          | SHIFT+F2         |
| Tools: View/Exclude Contractual Charges | CTRL+SHIFT+C / CMD + SHIFT + C |
|                          | F4               |

| Setup: Budget Preferences | CTRL+SHIFT+9 / CMD + SHIFT + 9 |
|                          |                               |
| Setup: Globals           | CTRL+G / CMD + SHIFT + G      |
| Setup: Fringes           | CTRL+3 / CMD + 3              |
| Setup: Groups            | CTRL+4 / CMD + 4              |
| Setup: Locations         | CTRL+5 / CMD + 5              |
| Setup: Currencies        | CTRL+6 / CMD + 6              |
| Setup: Units             | CTRL+7 / CMD + 7              |
| Setup: Sets              | CTRL+8 / CMD + 8              |

<p>| Data: Recalculate       | CTRL+F9 / CMD + F9           |
| Data: Reset Session and Change Totals | F5                        |</p>
<table>
<thead>
<tr>
<th>Function</th>
<th>Keyboard Shortcuts</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data: Show/Hide Original and Variance Columns</td>
<td>SHIFT+F5</td>
</tr>
<tr>
<td>Data: Show Fringe Total Column</td>
<td>CTRL+SHIFT+F5 / CMD + SHIFT + F5</td>
</tr>
<tr>
<td>Data: Make Fringe Range</td>
<td>CTRL+R / CMD + R</td>
</tr>
<tr>
<td>Data: Remove Fringe Range</td>
<td>CTRL+SHIFT+R / CMD + SHIFT + R</td>
</tr>
<tr>
<td>Data: Note</td>
<td>CTRL+SHIFT+(Space) / CMD + SHIFT + (Space)</td>
</tr>
<tr>
<td>Shortcuts: Create</td>
<td>CTRL+SHIFT+M / CMD + SHIFT + M</td>
</tr>
<tr>
<td>Shortcuts: Apply</td>
<td>CTRL+M / CMD + M</td>
</tr>
<tr>
<td>Worksheet: Hide Active Sheet</td>
<td>CTRL+SHIFT+0 (Zero) / CMD + SHIFT + 0 (Zero)</td>
</tr>
<tr>
<td>Library: Retrieve</td>
<td>CTRL+L / CMD + L</td>
</tr>
<tr>
<td>Library: Store</td>
<td>CTRL+SHIFT+L / CMD + SHIFT + L</td>
</tr>
<tr>
<td>Library: Manager</td>
<td>CTRL+Y / CMD + Y</td>
</tr>
<tr>
<td>Go to: Topsheet</td>
<td>CTRL+T / CMD + T</td>
</tr>
<tr>
<td></td>
<td>ALT+1</td>
</tr>
<tr>
<td>Go to: Accounts</td>
<td>SHIFT+CTRL+E / SHIFT + CMD + E</td>
</tr>
<tr>
<td></td>
<td>SHIFT+F9</td>
</tr>
<tr>
<td>Go to: Details</td>
<td>CTRL+SHIFT+D / CMD + SHIFT + D</td>
</tr>
<tr>
<td></td>
<td>ALT+3</td>
</tr>
<tr>
<td>Go to: Up from Selection</td>
<td>CTRL+U / CMD + U</td>
</tr>
<tr>
<td></td>
<td>F7</td>
</tr>
<tr>
<td></td>
<td>CTRL+(Arrow Up) / CMD + (Arrow Up)</td>
</tr>
<tr>
<td>Go to: Down into Selection</td>
<td>CTRL+D / CMD + D</td>
</tr>
<tr>
<td></td>
<td>F8</td>
</tr>
<tr>
<td></td>
<td>CTRL+(Arrow Down) / CMD + (Arrow Down)</td>
</tr>
<tr>
<td>Go to: First</td>
<td>CTRL+(Page Up) / CMD + (Page Up)</td>
</tr>
<tr>
<td>Go to: Previous</td>
<td>CTRL+9 / CMD + 9</td>
</tr>
<tr>
<td></td>
<td>CTRL+(Arrow Left) / CMD + (Arrow Left)</td>
</tr>
<tr>
<td></td>
<td>F9</td>
</tr>
<tr>
<td>Function</td>
<td>MMB- PC and Mac Shortcut Keys</td>
</tr>
<tr>
<td>------------------------------------------------------</td>
<td>---------------------------------------------</td>
</tr>
<tr>
<td>Show Unhide Sheet dialog</td>
<td>ALT+4</td>
</tr>
<tr>
<td>Toggle among open applications</td>
<td>ALT+TAB</td>
</tr>
<tr>
<td>Undo edits to a cell</td>
<td>ESC</td>
</tr>
<tr>
<td>Bring cursor to beginning of data in the cell or first cell in a line</td>
<td>HOME</td>
</tr>
<tr>
<td>Move to previous field</td>
<td>SHIFT+TAB</td>
</tr>
<tr>
<td>Move to next field</td>
<td>TAB</td>
</tr>
<tr>
<td>Jump cursor to Goto box (Goto box does not change; Account number can be entered)</td>
<td>CTRL+J / CMD + J (See Goto box atop Navigation bar)</td>
</tr>
<tr>
<td>Jump cursor to Goto box (Goto box is purple; name of 4th Level worksheet can be entered)</td>
<td>SHIFT+CTRL+4 / SHIFT + CMD + 4 (See Goto box atop Navigation bar)</td>
</tr>
<tr>
<td>Jump cursor to Goto box (Goto box is brown; name of a shortcut can be entered)</td>
<td>CTRL+M / CMD + M (See Goto box atop Navigation bar)</td>
</tr>
<tr>
<td>Change active cell to edit mode</td>
<td>CTRL+F2 / CMD + F2</td>
</tr>
<tr>
<td>Move Window Up</td>
<td>CTRL+(Numpad8) / CMD + (Numpad8)</td>
</tr>
<tr>
<td>Move Window Down</td>
<td>CTRL+(Numpad2) / CMD + (Numpad2)</td>
</tr>
<tr>
<td>Move Window Left</td>
<td>CTRL+(Numpad4) / CMD + (Numpad4)</td>
</tr>
<tr>
<td>Move Window Right</td>
<td>CTRL+(Numpad6) / CMD + (Numpad6)</td>
</tr>
<tr>
<td>Maximize Window</td>
<td>CTRL+(Numpad9) / CMD + (Numpad9)</td>
</tr>
<tr>
<td>Minimize/Iconize Window</td>
<td>CTRL+(Numpad5) / CMD + (Numpad5)</td>
</tr>
<tr>
<td>Global Display</td>
<td>F6</td>
</tr>
<tr>
<td>Hide Movie Magic Budgeting 7</td>
<td>No windows equivalent</td>
</tr>
<tr>
<td>Hide Others</td>
<td>No windows equivalent</td>
</tr>
<tr>
<td>Clear Applied Fringes</td>
<td>CTRL+(Space) / CMD + (Space)</td>
</tr>
</tbody>
</table>
Section 4: Starting a Budget

The first step is to open a new budget.

Starting a Budget from a Template

Movie Magic Budgeting 7 offers numerous budget templates to choose from, representing those most commonly used in the film and television industries.

There is also the option to choose from a list of personal budget templates saved from earlier budgets. This eliminates the need to re-set budget preferences.

1. Go to File and select New Budget.

The Templates folder will open.

**Note:** Be sure to have either MMB Templates or All Files selected in the Files of type field.

There are two methods to select a template:

1. Double-click on a template listing.
2. Select a template and click OK.

Starting a Budget from Scratch

Budgets may also be created from scratch.

**Note:** Although it is possible to create a budget from scratch, it is more common for a template to be used.

There are two methods to create a budget from scratch:
1. Go to **File** and select **New Budget**.

**Note:** **New Budgets** contain default tables information.

2. Select **New Budget.ept**.
3. Click on **OK**.

Or

1. Go to **File** and select **Create Blank Budget**

A completely blank budget will be opened immediately.

**Note:** Budgets can be saved as templates, detailed below in **Saving: Saving a Budget as a Template**. Also, **Blank Budgets** do not contain any default information.

**Opening a Budget**

From Movie Magic Budgeting 7:

1. Go to **File** and select **Open File**.

The most recent folder accessed will open.

2. Navigate to the folder that contains the budget to be opened.
3. Select the budget and click **Open**.

**Opening a Recently Accessed Budget**

Recent budgets are easily accessed.

From Movie Magic Budgeting 7:

1. Go to **File** and select **Reopen**.

A list of up to seven of the most recently accessed budgets will display in the order they were last opened.

2. Select the budget to be opened.

   **Note**: Re-open the last budget that was open on Movie Magic Budgeting 7 by hitting the **F12** function key on the keyboard.

**Accessing a Classic Movie Magic**

Movie Magic Budgeting 7 allows for accessing Classic Movie Magic Files. Movie Magic Budgeting 7 will create a separate Movie Magic Budgeting 7 file from a Classic Movie Magic File, while a selected Classic Movie Magic File will remain intact.

**Opening a Classic Movie Magic Budget**

1. Go to **File** and select **Open File**.

Navigate to the folder that houses Classic Movie Magic budgets.
2. Select either **All Files** or **Classic MMB** files from the **Files of type** drop-down list of choices.

3. If the **Classic Movie Magic Budget** is not in the currently opened folder, navigate to that folder with the navigation choices at the top of the window.

4. Open the **Classic Movie Magic budget**:
   - Double-click on the budget listing.
   - Or
   - Select it and click **Open**.
It will take a moment for Movie Magic Budgeting 7 to process the Movie Magic data. The Movie Magic budget will be opened in Movie Magic Budgeting 7.

Creating Movie Magic Budgeting 7 files from Classic MMB files

1. Open the Movie Magic budget.
2. Go to File and select Save or Save As.
3. Navigate to the location where the budget is to be saved.
4. Enter a file name.
Section 5: Saving

It is important to save work regularly. This protects work from accidentally being lost or destroyed. Entertainment Partners recommends as a best practice to save budget files to an external source, such as a flash drive or CD.

Save Reminder

Enable the Save Reminder to receive prompts at preset intervals of time to serve as a reminder to save a current budget. Once the Save Reminder setup is completed, it will be applied to all budgets.

1. Go to Options and select **Save Reminder**.

The Save Reminder Setup window will open.

2. Check the **Enable Save Reminder** option.
3. Select a **Delay** time from the drop-down menu.

**Note:** The Delay time reflects the intervals, in minutes, at which Movie Magic Budgeting 7 prompts to save budgets.
The Delay is divided into minute increments.

4. Click **OK** to save.

**Disabling Save Reminder**

Access the **Save Reminder Setup** window and deselect the **Enable Save Reminder** option. Click **OK** or hit the Enter key to complete this process.

**Save**

This saves the currently active budget.

1. Go to **File** and select **Save**.

   The current budget is now saved.

**Save All**

If more than one budget is open at the same time, this saves all of the currently opened budgets.

1. Go to **File** and select **Save All**.

   All of the currently opened budgets are now saved.

**Save As**

This makes a copy of the currently active budget and allows a copy to be saved under a different name.

**Note:** **Save As** is a recommended action from EP to save a budget as another file name on a hard drive or external drive as an added safety measure.

1. Go to **File** and select **Save As**.
The Budgets folder will open. If a budget is to be saved in a different folder, select it in the **Look in** field.

2. Type a new name for the budget in the **File name** field.
3. Click **Save** to save.

**Saving a Budget as a Template**

From an open budget:

1. Go to **File** and select **Make Template**. The budget template will be displayed immediately.
2. Click the Save button in the toolbar.
3. Navigate to the folder in which the template is to be saved.
4. Type a name for a new template in the **File name** field.
5. Click **Save**.

The new template will be accessible immediately.
Section 6: Exporting Budget Files

Movie Magic Budgeting 7 has several export options to share data with other users and applications. For example, if a co-worker is still using EP Budgeting 6.X, there is an export option to share the file with them. Movie Magic Budgeting 7 also allows easy exporting of files to EP Vista Accounting.

1. Go to File and then select Export.

2. Select the appropriate format to create the export file:
   - EP Vista Accounting (Native) - Tab
   - EP Vista Accounting (Converted) - XML
   - EP Vista Accounting (Native) - XML
   - Classic MMB 5.x file
   - EP Budgeting 6.6 File
   - Comma Delimited
   - Tab Delimited
   - Other Export (see additional details below)
The export file window for the method selected will open.

3. Select the location where the file is to be saved.
4. Enter a name for the export file in the File name field.
5. Click Save.

**Exporting to Classic Movie Magic 5.x**

When exporting to Classic Movie Magic, Movie Magic Budgeting 7 will convert the file into a Classic MMB file so it can be opened by Classic Movie Magic users. There will be a notification of any conflicts resulting from the data conversion. The original Movie Magic Budgeting 7 file will remain intact.

1. Select Export, then **Classic MMB 5.x File**.

2. A **MMB Data Conversion** status window will open.

3. Click OK to continue.

4. Name and select the location to which to save the converted file.
5. Click Save.
**Note:** It is necessary to run a Complete Recalculation in Classic Movie Magic Budgeting after first opening an exported Movie Magic Budgeting 7 file. This is due to design differences between Movie Magic Budgeting 7 and Classic Movie Magic Budgeting. Discrepancies can appear because of variations in the rounding routines between the two applications. A Movie Magic Budgeting 7 file rounds at the Account Level, while Classic Movie Magic rounds at the Topsheet Level. Expect plus (+) or minus (-) $1 for the total number of accounts budgeted in EPB.

**Other Export**

If a company has a predefined export format, then the Other Export function can use an export template to create a custom export file.

From File:

1. Go to Export and select **Other Export**.

   ![Export Budgeting using a template window](image)

   The **Export Budgeting using a template** window will display.

2. Select the desired template.
3. Click on **Export Chooser**.
4. Select a directory to which to write the export file.
5. Enter a File name.
6. Click OK to save.
Chapter 2: Budget Setup

Once preferences are set for a budget, the processes will not need to be repeated with each newly created budget. Instead, the system allows for a budget and its preferences to be saved as a template, meaning it can be used to create new budgets. Modifications may be made as necessary for new budgets.

Section 1: Budget Preferences

First, access the Setup Preferences window.

1. Go to Setup and select Budget Preferences.

The Setup Preferences window will open.

The Setup Preferences window is comprised six main sections:

- General Properties
- Fringe
- Detail Level
- Currency
- Totals
- Account Format
- Optional Columns

Each section is populated with fields and drop-down menu options. The window also has:

- Restore to Default, OK, and Cancel buttons.

General Properties

There is only one feature in the General Properties window: Set Budget Font.
1. Click the **Set Budget Font** button to open the **Select Font** window.

2. Reveal the drop-down menu of options for each font characteristic (Fonts, Sizes, Styles) by clicking on the small downward-facing arrow.

3. Click **OK** to save a font selection.

**Fringe**

This window controls how the Fringe amounts appear in a budget.

**Note:** To fringe a budget by Category, enter the preferred Account number in the Fringe Category Acct. No. field. For example, Category 1100 fringes in 99 or 1199.

**Aggregate Fringe Percentage Computation**

Select the Aggregate Fringe Percentage calculation for a budget.

- **Fringe total/Line total (default):** Divides the Total Fringe Contribution by the Line Total

- **Sum of Fringe Percentage:** Adds the percentage of all the Percentage Fringes applied to the line of Detail (Flat Rate Fringes are excluded)

**Post Fringes by**
Select how Fringes will be displayed in a budget.

- **Budget (default)**: Displays the budget’s Fringe totals in the Topsheet

- **Production Level**: Creates Categories for each Topsheet Level Break; Above-the-Line Category Fringes are totaled and posted to the Above-the-Line Fringe Account. This applies for all Level Breaks.

- **Category**: Creates an Account at the end of each Category; the Fringes in each Account are totaled and displayed in the Fringe Account. An Account number must be indicated for the Category Fringes

- **Account**: Adds the Fringes Total to each Account; Fringes are totaled and displayed into line items at the end of the Account.

**Detail Level**

![Detail Level](image)

**Inserting a Detail Line**

Selecting any of these options will default the application to insert the selected properties from the previous Detail line to the current Detail line.

For example, if a Detail line has a Currency in Canadian dollars and the Currency option in Budget Preferences is checked, the next Detail line that is manually inserted or created will default to also show the Canadian currency.

![Detail Line Example](image)

**Rate Column Display (Optional)**

![Rate Column Display](image)
Rate Column Display Cutoff

This is the numerical figure selected to determine parameters regarding how many decimal places should be displayed for a rate. It will define the regions for the Precision Below and Precision Above Cutoffs.

Precision Below Cutoff

This is the number of decimal places displayed for rates that fall below the Cutoff.

Precision Above Cutoff

This is the number of decimal places displayed for rates that fall above the Cutoff.

Example: Cutoff is set for 100, Precision Below is set for 2 (decimal places), and Precision Above is set for 3 (decimal places).

If a rate of 101.237 is entered in the Rate column of the budget at the Details Level, the entire rate of 101.237 would be shown because the Precision Above Cutoff is set for 3 and the number already has three decimal places after the decimal point (101.237).

If the rate falls below 100, the decimal places would be constrained to two. A number of 99.988 would be shown as 99.99.

Default

Default is a number entered in the rate cell. When Default is selected, the number that is entered in the rate cell becomes the default.

Note: If a Global is entered with its own precision set up previously in the Globals table, its precision would prevail in the Rate column at the Details Level.

Currency

Selecting this option will automatically apply the Base Currency to any new row added. Specify Base Currency in the Currency Setup. See Currency Table Setup.

Note: U.S. (United States) is the default base currency. However, another currency can be defined as the base if necessary.

Totals

The amounts that display in the Summary Total row on the Topsheet are determined by information entered and calculated on the Details Level. As a default, only the
current **Totals** column is visible on the Topsheet. To view the **Original** and **Variance** columns, they must be put on **Unhide** (see **Chapter 3: Topsheet, Viewing Topsheet Columns**).

### Display Summary Totals (Default)

**Selected (Checked):** Movie Magic Budgeting 7 displays three default summary rows at the bottom of the Topsheet: Total Above-The-Line, Total Below-The-Line, and Total Above and Below-The-Line.

**Note:** These will not appear unless there is at least one Production Total inserted onto the Topsheet.

<table>
<thead>
<tr>
<th>Original Totals</th>
<th>Variance Totals</th>
<th>Grand Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Above-The-Line</td>
<td>$3,129,000</td>
<td>$3,129,000</td>
</tr>
<tr>
<td>Total Below-The-Line</td>
<td>$1,285,900</td>
<td>$1,285,900</td>
</tr>
<tr>
<td>Total Above and Below-The-Line</td>
<td>$3,414,900</td>
<td>$3,414,900</td>
</tr>
</tbody>
</table>

**Deselected (Unchecked):** There will be no summary totals displayed at the bottom of the Topsheet.

<table>
<thead>
<tr>
<th>Original Totals</th>
<th>Variance Totals</th>
<th>Grand Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Above-The-Line</td>
<td>$695,900</td>
<td>$695,900</td>
</tr>
<tr>
<td>Total Below-The-Line</td>
<td>$1,285,900</td>
<td>$1,285,900</td>
</tr>
<tr>
<td>Total Above and Below-The-Line</td>
<td>$2,981,800</td>
<td>$2,981,800</td>
</tr>
</tbody>
</table>

### Lock Original Totals for Comparison

**Selected (Checked):** The Original Totals are “locked” and will not be changed.

If the original budget totals are not to be altered, check this box. However, once this box is checked, it must be unchecked for the Original Total to reflect budget changes. For further instruction on Comparison Totals and the Original and Variance columns, refer to **Chapter 2: Budget Setup**.

**Example:** When working with the Original Totals locked, the **Totals** column must be recalculated to reflect the changes after altering a budget.

<table>
<thead>
<tr>
<th>Original Totals</th>
<th>Variance Totals</th>
<th>Grand Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Above-The-Line</td>
<td>$3,129,000</td>
<td>$3,129,000</td>
</tr>
<tr>
<td>Total Below-The-Line</td>
<td>$1,285,900</td>
<td>$1,285,900</td>
</tr>
<tr>
<td>Total Above and Below-The-Line</td>
<td>$3,414,900</td>
<td>$3,414,900</td>
</tr>
</tbody>
</table>

© 2009 Entertainment Partners
1. Deselect (uncheck) the **Lock Original Totals for Comparison** option.
2. Go to **Data** and select **Comparison Totals**.
3. Select **Show Original and Variance Column**
4. Select **Update Original Column Totals** and notice that the Original column now matches the current totals.
5. Go back to the Budget Preferences window and check the **Lock Original Totals for Comparison** box to keep the new Original Column Totals data from changing. Now all changes will be reflected in the Variance column.

![Updated Totals](image)

**Note:** To update the Original Column Totals, uncheck the Lock Original Totals for Comparison box.

**Account Format**

The user has control over how many digits the Category, Account, and Set column widths should allow for.

![Account Format](image)

**Category Width**

This controls the number of digits shown in the Category portion of the Account number. In the example 100-12, the Category number is 100, with the Category Width set to 3.

1. Click on the Category Width number selection.

   ![Account Format](image)

   A drop-down menu of Category Width options (1-6) will be displayed.

2. Select a Category Width number.
3. Click **OK** to save.
Account Width

Controls the number of digits to be shown in the Account portion of the Account number. In the example number 100-12, the Account number is 12, with the Account Width set to 2. In the example number 100-123, the Account number is 123, with the Account Width set to 3.

1. Click on the Account Width number selection.

<table>
<thead>
<tr>
<th>Account Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category Width: 2</td>
</tr>
<tr>
<td>Account Width: 2</td>
</tr>
<tr>
<td>SubAccount Width: 3</td>
</tr>
<tr>
<td>Set Width: 1</td>
</tr>
<tr>
<td>Category/Account Separator: 0</td>
</tr>
<tr>
<td>Optional Columns: 1</td>
</tr>
</tbody>
</table>

A drop-down menu of Account Width options (1 to 6) will be displayed.

2. Select an Account Width number.
3. Click OK to save.

SubAccount Width

Controls the number of digits/letters shown in the SubAccount column in the Details Level.

<table>
<thead>
<tr>
<th>Account Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category Width: 2</td>
</tr>
<tr>
<td>Account Width: 2</td>
</tr>
<tr>
<td>SubAccount Width: 3</td>
</tr>
<tr>
<td>Set Width: 0</td>
</tr>
<tr>
<td>Category/Account Separator: 2</td>
</tr>
<tr>
<td>Optional Columns: 3</td>
</tr>
</tbody>
</table>

Set Width

Controls the number of digits/letters shown in the dedicated Set column in the Details Level. For example, if 2 is selected (as a default) for Set Width, only two digits/letters can be typed in the Set name in the Setup Set window and the Set column of the Details Level.

1. Click on the Set Width number selection.
A drop-down menu of Set Width options (1-6) will be displayed.

2. Select a Set Width number.
3. Click OK to save.

The new Set Width parameters will take effect the next time the budget is opened. The budget must then be saved, closed, and then re-opened to immediately view the new settings.

**Category/Account Separator**

Select the Separator to distinguish the Category from the Account portions of an Account number.

1. Click on the Category/Account Separator selection.

   ![Category/Account Separator](image)

   A drop-down menu of Separator options will be displayed.

2. Select a Separator.
3. Click OK to save.

Three Separator options:

- None (Default)
• Space

![Space Table]

• Hyphen

![Hyphen Table]

**Note:** The hyphen will not translate to Vista if a budget is exported to Vista accounting software.

### Optional Columns

Movie Magic Budgeting 7 provides extra columns for additional budget calculations. It provides the option to expand a budget to include four additional Unit columns and one additional Rate column. The offers greater inputting flexibility. Check the box for the optional column to be activated.

<table>
<thead>
<tr>
<th>Optional Columns</th>
</tr>
</thead>
<tbody>
<tr>
<td>☐ 2nd Units</td>
</tr>
<tr>
<td>☐ 3rd Units</td>
</tr>
<tr>
<td>☐ 4th Multiplier</td>
</tr>
<tr>
<td>☐ 4th Units</td>
</tr>
</tbody>
</table>

The additional column will be available immediately.

**Note:** Deactivating the 4th Multiplier either in Preferences or at the Details Level will remove it from the budget calculations. This could potentially affect totals.

### Section 2: Captions

Movie Magic Budgeting 7 allows for the **Captions** to be edited. Captions are budget labels, such as **Category Description**, **Total**, **Groups**, or **Set**. They are usually in the green-shaded, non-editable fields. The Captions window allows for editing them or changing them entirely.

#### Changing Caption Names

1. Go to **Setup** and select **Captions**.
The **Captions** window will open.

The left column is labeled **Default Name**. The default name of any Caption cannot be altered. The Caption, however, can be renamed in the right column and labeled **Current Name**.

2. Click in the field with the Caption to be edited.
3. Type the new name for the Caption.
4. Click **OK**.

**Note:** Budget Info Captions are the only captions that cannot be edited.

The new Caption name will be saved and will be apparent immediately.

### Restore Default Settings

Click the revert button to restore the **Current Name** Captions to the **Default Name** Captions.

### Section 3: Units

Units are shortcuts used in the Detail Level's Unit field. Type a letter into the Unit field and it will expand or auto-complete to its full, pre-assigned text. Movie Magic Budgeting 7 features a list of preset standard Units ready for use, such as **D** for **Day** and **W** for **Week**. The Units feature also recognizes plural versions of the Unit and will display the appropriate version.

<table>
<thead>
<tr>
<th>Preset Units:</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Allow</td>
</tr>
<tr>
<td>D</td>
<td>Day(s)</td>
</tr>
<tr>
<td>F</td>
<td>Flat</td>
</tr>
<tr>
<td>H</td>
<td>Hour(s)</td>
</tr>
<tr>
<td>M</td>
<td>Month(s)</td>
</tr>
<tr>
<td>T</td>
<td>Foot (Feet)</td>
</tr>
<tr>
<td>LR</td>
<td>Reel(s)</td>
</tr>
<tr>
<td>W</td>
<td>Week(s)</td>
</tr>
</tbody>
</table>
Setting Up a New Unit

Units may be assigned in addition to the pre-assigned ones.

1. Go to **Setup** and select **Units**.

![Setup Units Window](image)

The Setup Units window will open.

2. Add a new Unit.

The first available field in an empty row will be highlighted and ready to be filled. It will be at the bottom of the Unit listing. If there is not already an empty row, use one of the following methods to create one.

**Note:** The scroll bar may be needed to get to the new row if it is not readily visible.

**Two Methods:**

- Click on the **Add a Row** icon.
- Tab past the end of the last row, which will create a new, empty row.

3. Type a letter for the new Unit (for example, D for day). This single letter will be the new unit’s assigned key.

4. Tab to or click in the next field, **Singular**.

5. Type the entire word for the Unit, in its singular form (for example, **Day**).

6. Tab to or click in the next field, **Plural**.

7. Type the entire word for the Unit, in its plural form (for example, **Days**).

8. Tab to or click in the next field, **Unit Equiv. (hrs)**. This field converts the units into their hour equivalents, used in association with the Fringe table, for flat-rate fringing in the budget. The hour equivalents are editable.
9. Type in the hour equivalent to be assigned to the unit. For example, there are 12 hours in a working Day, so type 12 for the Day Unit.

The default table is based on Work Hours. A Day (unit) is represented as 12 hours. Certain employees are paid based on a 12-hour day. They do not necessarily work the entire 12 hours, but that is how they are paid. Thus, 12 hours a day, 60 hours a week and 240 hours a month.

If the unit is never used in flat-rate Fringe calculations, tab through or click OK. No will default into the field.

To Delete a Unit Row

1. Select the row to be deleted.
2. Click on the Delete a Row icon.

Note: A unit that is in use cannot be deleted. If this is attempted, a warning message will be displayed.

To Print Preview of Units Report

1. Click on the Print Preview icon.

2. The Units Report will immediately come up as it would look when printed.

PDF File

Movie Magic Budgeting 7 also provides the flexibility to convert a Units Report, as well as all other reports, into a PDF file using two possible methods.

Two Methods:
From the **Print Preview** window:
1. Click on the **PDF File** icon.

Or

From the **Setup Units** window:
1. Click on the **PDF File** icon.

**To Print a Units Report**

1. Click on the **Print** icon.

> There is a **Print** icon located both in the **Setup Units** window as well as in the **Units Report Print Preview** window.

**Section 4: Location**

**Location Setup**

1. Go to **Setup** and select **Locations**.
The Locations setup window will open.

2. Tab to or click in an empty Name field.

3. Type a Name for the Location.
4. Tab to or click in the next field, Description.
5. Type a description of the Location (optional). The Total field will automatically track the total cost for the Location. It was also track any corresponding fringes when the Location name is entered in the Locations cell in the Details Level of a budget.

6. Click OK to save.

Deleting Locations

1. Select the Location listing to be deleted.
2. Click the Delete a Row button.

3. Click OK.

Section 5: Set

Set Setup

1. Go to Setup and select Sets.

   The Set Setup window will open.

2. Tab to or click in an empty Name field. If there is no empty row, click on the Add a Row icon.
3. Type a name for the Set.

**Note:** Set names may be numeric, alphanumeric, or made up exclusively of letters.

The number of digits/characters in the name will be constrained by the Set Width selection in the Budget Preferences (refer to **Chapter 2: Budget Setup**).

4. Tab to or click in the next field, **Description**.

5. Type a description of the **Set** (optional).

The **Total** field will automatically track the total cost for the Set and any corresponding fringes when the Set name is entered in the Set cell in the Details level of a budget.

6. Click **OK** to save.

### Deleting Sets

1. Select the Set listing to be deleted.

2. Click the **Delete a Row** button.

3. Click **OK**.

**Note:** A warning message will display if there is an attempt to delete sets that have been applied in the budget.

### Section 6: Currencies

Any currency can be used in calculating a budget. This is helpful for budgeting productions that will be filmed in foreign countries. Add the currencies to be used in budgeting into the Currency table. They can be applied in the Dedicated Currency Column at the Details Level of a budget.

**Note:** The default base currency is the U.S. Dollar with a default rate of 1.0.

The Currencies setup window is composed of eight columns:

- **Conv:** This selection is for converting to a designated currency.
- **Base:** Other currencies of a budget are based on this selection.
- **Name**: This appears in the Currency column of the Details Level in a budget usually as an abbreviation of the full Currency name. For example: U.S. is the name for United States dollars.
- **Description**: This is an optional field usually for the full spelling of the currency name.
- **Symbol (Smbi)**: This appears next to each amount of currency. For example: The dollar sign ($) is the symbol for U.S. dollars.
- **Right (Rt)**: Checking this option relocates the currency symbol to the right of the amount. For example: 100$.
- **Separator (Sep)**: This allows for specifying a separator other than the default comma (,). For example: If a period (.) is placed in the Sep column, 1,000 will now be displayed as 1.000.
- **Rate**: This is the currency value or exchange rate (based on the base currency value).

### Setting Up/Adding Currencies

1. Go to **Setup** and select **Currencies**.

![Currency Setup Window](image)

The Currency Setup window will open.

2. Select the currency to be used as the **Base** currency.

3. Select an empty row or click the **Add a row** (Alt + A) icon to create one.
4. Tab to or click in the new, empty Currency field.
5. Type the currency abbreviation to be used for the new currency.
6. Tab to or click in the next field, **Description**, and type the full name of a new currency (optional).
7. Tab to or click in the next field, **Smbi**, and enter the symbol for the new currency (optional).
8. Tab to and click in the next field, **Rt**, to have the symbol be displayed to the right of the amount (optional). Otherwise it will default to the left.
9. Tab to or click in the next field, **Sep**, and enter the separator that is to be displayed in currency amounts (optional).
10. Tab to or click in the next field, **Rate**, and type the current exchange rate for the new currency. The **Rate** field will retain five digits after the decimal point (e.g. 1.25252). If fewer than five digits are entered, zeroes will be added to fill all five decimal places.
11. Click **OK** or hit the **Enter** key to save.
Quick Pick

Quick Pick expedites the currency setup by selecting from a predetermined list of currency names, descriptions, and symbols.

From the Currencies Setup window:

1. Select the **Name** field of an empty row into which the **Quick Pick** currency name will be inserted.
2. Click on the **Quick Pick** field to reveal a drop-down menu of country names.
3. Select the country’s currency to insert.
4. Complete the entry by entering the correct **Conversion** or **Exchange Rate**.
5. Click **OK** to close the Currency Setup window.

Deleting Currencies

1. Go to **Setup** and select **Currencies**.
2. Select the currency to delete by clicking on its table number (left).
3. Click on the **Delete a Row** icon.

**Note**: A warning message will display if there is an attempt to delete a currency that is in use.

The Currency table will reflect the deletion immediately.
Applying Currencies

Applying Currencies by Individual Detail Line

For this operation, the necessary exchange rates in the Currency table will already need to be set (this is detailed above in Setting Up Currencies).

From the Details Level:

1. Open the dedicated Currency column by clicking on the Cur toggle located on the left side of the Details Level Toolbar.

2. Type the Currency name to be applied in the Currency column. The budget numbers will change to reflect the new Currency when tabbed or clicked off of the Currency column.

Applying a Currency to the Entire Budget

There are 2 ways to convert the currency of a budget. One way is to convert what the base currency is; the other is to convert the currency of the entire budget. Converting the base will convert what the default currency is, but will keep the totals in the converted currency.

From the Currency Setup window:

1. Select the Base radio button for the currency to be applied to the entire budget as base.
2. Select the Convert radio button for the currency in which totals are to be displayed.

Section 7: Comparison Totals

Movie Magic Budgeting 7 gives the user the option to show or hide the Original and Variance Columns from the Topsheet. The default selection hides the Original and Variance Columns.

Comparisons are normally generated when a budget, or portion of a budget, has been created and changes are needed. They are also generated to create a different scenario to compare with the original version.

To Show Original and Variance Columns

From the Topsheet:

1. Go to Data and select Comparison Totals.

Or
2. Select **Show Original & Variance Columns**.

   The Original and Variance columns will immediately display.

   To hide the columns, simply repeat the above steps and select the **Hide** option. Once the columns are hidden, the **Show Original & Variance Columns** option will be displayed in place of the hide option.

**Update Original Column Totals**

Once changes have been made to a budget, it may be necessary to update the Original Column Totals to be current with the most recent Totals of the Budget. If the **Lock Original Totals for Comparison** option is checked in **Budget Preferences**, it will need to be unchecked before updating the totals (see **Chapter 2: Budget Setup**).

**To Update the Original Column Totals**

From the Topsheet:

1. Uncheck the **Lock Original Totals for Comparison** option in **Budget Preferences**.
2. Go to **Data** and select **Comparison Totals**, then **Update Original Column Totals**.

   The current Totals will be inserted into the Original Column as the Original Totals.
3. Return to the **Budget Preferences** window and check the **Lock Original Totals for Comparison** option.

As additional changes to the budget are made, the **Total** and **Variance** columns will reflect those changes.

<table>
<thead>
<tr>
<th>Original</th>
<th>Total</th>
<th>Variance</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>2,140,900</td>
<td>2,140,900</td>
<td>0</td>
</tr>
<tr>
<td>316,050</td>
<td>316,050</td>
<td>0</td>
</tr>
<tr>
<td>242,267</td>
<td>242,267</td>
<td>0</td>
</tr>
<tr>
<td>230,000</td>
<td>230,000</td>
<td>0</td>
</tr>
<tr>
<td>217,427</td>
<td>217,427</td>
<td>0</td>
</tr>
<tr>
<td>4,831,356</td>
<td>4,831,356</td>
<td>0</td>
</tr>
<tr>
<td>1,096,253</td>
<td>1,096,253</td>
<td>0</td>
</tr>
<tr>
<td>96,114</td>
<td>96,114</td>
<td>0</td>
</tr>
<tr>
<td>1,386,453</td>
<td>1,386,453</td>
<td>0</td>
</tr>
<tr>
<td>2,578,820</td>
<td>2,578,820</td>
<td>0</td>
</tr>
<tr>
<td>4,001,785</td>
<td>4,001,785</td>
<td>0</td>
</tr>
<tr>
<td>58,979,195</td>
<td>58,979,195</td>
<td>0</td>
</tr>
<tr>
<td>62,980,980</td>
<td>62,980,980</td>
<td>0</td>
</tr>
</tbody>
</table>

**Section 8: Budget Info**

Basic information about a budget is gathered in the Budget Information window for quick reference. The Budget Information window is divided into five spaces: **Budget Information**, **Currency**, **Budget File**, **Total Number of Items**, and **Remarks**.

**Access Budget Info**

1. Go to **File**. Then, select **Budget Info**.
The Budget Info window will open immediately.

**Budget Information**

This space allows for entering general information about the budget, such as the title and number.

- **Budget Title**: Enter the Budget’s or Production’s full title here.
- **Budget Number**: Enter the Budget Number here.
- **Revision Number**: Enter the Revision number here.

**Currency**

This space displays the currency information for a current budget.

**Budget File**

This area details the budget’s file information, such as the full file location path and date of creation and last update.

- **Current filename**: Displays the current path and filename of the budget.
- **Previous filename**: Displays the path of the budget template or original budget from which the budget was created
- **Filename before that**: Displays another level of save history
- **Date Created**: Displays the date of the original file save
- **Date Last Updated**: Displays the date of the latest file save

**Total Number of Items**

This area displays the total number of each budget item. The number that follows the item listing reflects the quantity of the item existing throughout the budget. The item listings are as follows:

- **Total Categories**
- **Total Accounts**
- **Total Details**
- **Total Fringes**
- **Total Globals**
- **Total Groups**
- **Total Units**
- **Total Locations**
- **Total Sets**
- **Total Currencies**
• **Total No. of 4th Levels**

Once Budget Information has been entered, click the **OK** button to save.

**Remarks**

Enter any notes or remarks about the budget here.

**Note:** This area can be used as a Critical Assumptions page.

**Printing an Info Report**

• **Print:** Click the **Print** icon to print a report of the Budget Info.

• **Print Preview:** Click the **Print Preview** icon to view the Report onscreen before sending it to print.

• **PDF File Conversion:** Click the **PDF** icon to save a copy of the Info Report as a PDF file.
Chapter 3: Topsheet

The Topsheet is the first layer of a budget. It is also the budget summary. Category names (or major Account names) of a budget, such as Art Direction, Set Construction, and Production Staff as well as their Account numbers are entered in the Topsheet. Except for Contractual Charges and Credit Adjustments, monetary amounts are not entered here. Although Level Breaks, Summary Total Rows, Contractual Charges, and Credit Adjustments are also entered on the Topsheet, the majority of the information reflects manually entered data in the succeeding layers: Accounts Level and Details Level.

Section 1: Accessing the Topsheet

A budget should open with the Topsheet. There are five methods of accessing a Topsheet from different budget levels.

Five Methods:

- Click on the Topsheet icon on the tool bar.
- Go to Goto and select Topsheet.
- Click on the arrow up on the Navigation Ball on the tool bar until the Topsheet is reached.
- Go to Goto and select Up from selection until the Topsheet is reached.
- Click the F7 function key until the Topsheet is reached.

Viewing Topsheet Columns

Right-click (Mac: CTRL + click) on the green bar atop the Topsheet to:

- Show Original & Variance Columns
- Update Original Column Totals
- Show Fringe Total Column
A Topsheet displaying Original & Variance and Fringe Total columns will look like this:

### Hiding Topsheet Columns

To hide the Original & Variance and Fringe Total columns, right-click (Mac: CTRL + click) on the green bar atop the Topsheet and select the columns to hide.

### Entering Category Names and Numbers

1. Click or tab into a blank **Acct No** field.
2. Type the account number for the category.
3. Tab to or click in the next field, **Category Description**.
4. Type the Category Description.

### Renaming Categories

1. Double-click inside the **Category Description** field. The mouse arrow will become a text edit icon.
2. Double-click on the Category Description itself. The current category name will be highlighted.
3. Type the new name.

**Note:** It is also an option to tab into the name field and begin typing the new name.

### Inserting New Category Rows

1. Select the row above which the new row will be inserted.
2. Go to **Edit** and select **Insert Row**.

The new empty Category row will be displayed above the selected row.
Removing Categories

1. Select the Category to be removed.
2. Go to Edit and select Delete Row.

**Note:** A warning message will display if there is an attempt to remove Categories that have been applied in the budget.

Editing Categories

The Cut, Copy, and Paste options can also be used to edit Categories. The row itself can be edited, as well as the content and fields within each row.

Copying a Row or Field

Copying a row or field allows for pasting the copy in a new location. An entire range of rows and fields may also be copied by clicking and dragging the mouse over the desired area (or by holding down the Shift + Arrow keys).

1. Select the row(s), field(s), or row content to be copied.
2. Go to Edit and select Copy.

Cutting a Row or Field

1. Select the row(s), field(s), or the row content to be cut.
2. Go to Edit and select Cut.

Pasting a Row or Field

Pasting a row will replace whatever was in the location before the paste.

1. Select the row or field to be replaced.
2. Go to Edit and select Paste.

The new row or field will be displayed in the selected location.

**Note:** Only the last elements cut may be pasted. That is, if the cut action is used more than once, only the last action will be available for pasting.

Section 2: Level Breaks

Inserting Production Total Rows (Level Breaks)

1. Select the Category row above where the Production Total row is to be inserted.
2. Go to Edit and select Insert Production Total.

A Level Break, titled Untitled Production Total, will be displayed above the selected row.
Section 3: Note

Movie Magic Budgeting 7 features a Note tool that allows the user to attach short messages to individual Topsheet, Accounts, Details, and 4th Level lines.

Attaching a Note

Two Methods:

- First select the line to which to attach a Note.
- Go to Data and select Note.

Or

- Right-click (Mac: CTRL + click) on highlighted row and select Note.

The Note window will open.

1. Type the Note directly into the window.

**Note:** To add a new line to a Note, type Alt-Enter.

2. Select the Include in Print Report box to include the current Note when printing a budget report.
3. Click OK or hit the Return key to save the Note and close the window.

Any budget lines with attached Notes are indicated with a red pin icon to the right of each line.
Accessing a Note

Two Methods:

- First select the line that contains the Note to be accessed by clicking on the line item number on the left side.
- Right-click (Mac: CTRL + click) on the selected line number and select Note from the menu that appears.

Or

- Go to Data and select Note.

Section 4: Contractual Charges

Contractual Charges are Topsheet line items that are not comprised of Accounts and Details. However, when a Contractual Charge is created, there is the option to assign an Account number by entering a number in the Account Number field of the Contractual Charge window. Contractual Charges are usually a flat rate or a percentage. Examples include Contingency, Bond Fee, Insurance Charges, and Tax Incentive Credits. There is also the flexibility to exclude specific budget amounts from the Contractual Charge calculation, such as copyright fees and groups, which typically do not need to insured or bonded.

Using Contractual Charges

Usually, Contractual Charges are placed on the Topsheet after the last Level Break and before the Budget Grand Total.

Inserting Contractual Charges

1. Select the row above which the Contractual Charge is to be placed.
2. Go to Edit or right-click (Mac: CTRL + click) and select Insert Contractual Charge.
The Contractual Charge window will be displayed.

3. Type the Contractual Charge name in the Name field.
4. Select a Charge Type from the drop-down menu.
5. Enter the Charge Type amount.

   If a Percentage Charge Type is selected, enter a percentage number in the Percentage field.

   Or

   If a Flat Fee Charge Type is selected, enter a flat fee amount in the Flat Fee field.

**Note:** Only one Charge Type may be chosen at a time. However, the other Charge Type amount will be calculated and displayed in its corresponding field as a ghosted number. For example, if a Percentage Charge Type is chosen, the Flat Fee number will be calculated to display as a ghosted number in the Flat Fee field.

6. Enter an Account Number for the Contractual Charge line (optional).
7. Select how the Contractual Charge is to be displayed in the Topsheet.
8. Enter what is to be excluded from the Contractual Charge (optional).
9. Click OK.

The newly created Contractual Charge line will be displayed in the chosen area.

**Note:** A specific Contractual Charge window can be accessed by double-clicking on the Contractual Charge budget line number.

**Charge Types**

The default Charge Type is Percentage.
Percentage

This is the percentage amount that is to be charged against the budget total and used to calculate the Contractual Charge total.

Flat Fee

This is the flat amount that is to be charged as the Contractual Charge total.

To edit either of these fields, tab directly into the field and hit the Delete key.

**Note:** There is a limit of four characters, including symbols and decimals, in the percentage field.

Excluded from Contractual Charge

Charges that are excluded from the Contractual Charge are not included in the Contractual Charge total calculations. It is possible to exclude single budget line items or entire groups.

Excluding a Line Item

There are two methods to exclude a budget line item from Contractual Charges. First, it is an option to exclude an amount that is linked to a line item in a budget. The second option is to enter an amount manually to be excluded.

Excluding a Budget Linked Item

From a budget:

1. Select the line item to be excluded.
2. Go to **Tools** and select **View/Exclude Contractual Charges**.

All of the Contractual Charges in a budget will be listed in the **View/Exclude Contractual Charges** window.

3. Select the Contractual Charge to be excluded from the line item.
4. Click the X to close.
5. Hit **F9**, the Recalculate key, or go to the **Data** menu and select **Recalculate**.

The Contractual Charge total will reflect the newly excluded charges. Reopen the Contractual Charges window to view the newly excluded line item.

**User Entry (Manually Entered Contractual Charge Exclusion)**

From the Topsheet:
1. Double-click on the **Contractual Charge** in which the exclusion is to be made.
2. Click the **Exclude Amount** button.

A new user entry will be displayed in the **Excluded from this Budget Adjustment** section.

3. Type the **Description** of the item to be excluded.
4. Enter the **Amount** of the item that is to be excluded.
5. Click **OK**.

The Contractual Charge total will reflect the newly excluded charges. If not, run a recalculate.

**To Recalculate**

Go to the **Data** menu and select **Recalculate**.

**Excluding a Group**

1. Double-click on the Contractual Charge line item number.

The Contractual Charge window will open.

2. Click on the **Exclude Group** button.

The Excluded Group window will display, listing all the groups that have been created for this budget.
3. Select the Group that is to be excluded from the Contractual Charge.
4. Click **OK** to save.

The Contractual Charge window will now list the newly excluded Group.

5. Click **OK**.

The Contractual Charge line will display the newly excluded amount, if the option was checked in the Contractual Charge window.

**Delete a Line Item or Group**

It is also possible to want to take a budget line item or Group off of the Contractual Charges excluded list.

1. Select the currently excluded specific line item or Group that is to be included from the Contractual Charges.
2. Click on the **Delete** button.

The item or group will no longer be excluded from the Contractual Charges total. The Contractual Charges total will automatically recalculate to reflect the updated total.

The Total Excluded Amount will be automatically calculated.

3. Click **OK** to save.

**Deleting a User Entry (Manually Entered Contractual Charge Exclusion)**

1. Double-click the Contractual Charge line number.
2. Select the User Entry to be deleted from the list of items excluded from the Contractual Charge.
3. Click the **Delete** button.

A confirmation inquiry message for the deletion will display.
4. Click Yes.

The selected User Entry will be deleted immediately.

**Topsheet Display and Misc. Options**

- **Display Percentage in Topsheet Description**
- **Display Excluded Amount in Topsheet Description**

**Display Percentage in Topsheet Description**

Selecting this option will display the percentage of the overall budget assigned to the Contractual Charge.

<table>
<thead>
<tr>
<th>Total Below-The-Line Post</th>
<th>7,162,893</th>
<th>4,784,556</th>
<th>(2,378,336)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bond 2 : 0.1%</td>
<td>0</td>
<td>50,000</td>
<td>50,000</td>
</tr>
<tr>
<td>Bond 1 : 10.0% (276,794 excluded)</td>
<td>0</td>
<td>6,765,539</td>
<td>6,765,539</td>
</tr>
<tr>
<td>INSURANCE</td>
<td>1,448,162</td>
<td>1,448,162</td>
<td>(354,543)</td>
</tr>
<tr>
<td>PUBLICITY</td>
<td>74,340</td>
<td>74,340</td>
<td>(96,144)</td>
</tr>
<tr>
<td>GENERAL EXPENSE</td>
<td>8,000</td>
<td>8,000</td>
<td>12,773</td>
</tr>
<tr>
<td>Total Below-The-Line Other</td>
<td>2,431,251</td>
<td>8,894,358</td>
<td>6,403,007</td>
</tr>
</tbody>
</table>

With **Display Excluded Amount in Topsheet Description** item selected:

<table>
<thead>
<tr>
<th>Total Below-The-Line Post</th>
<th>7,162,893</th>
<th>4,784,556</th>
<th>(2,378,336)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bond 2 : 0.1%</td>
<td>0</td>
<td>50,000</td>
<td>50,000</td>
</tr>
<tr>
<td>Bond 1 : 10.0% (276,794 excluded)</td>
<td>0</td>
<td>6,765,539</td>
<td>6,765,539</td>
</tr>
<tr>
<td>INSURANCE</td>
<td>1,448,162</td>
<td>1,448,162</td>
<td>(354,543)</td>
</tr>
<tr>
<td>PUBLICITY</td>
<td>74,340</td>
<td>74,340</td>
<td>(96,144)</td>
</tr>
<tr>
<td>GENERAL EXPENSE</td>
<td>8,000</td>
<td>8,000</td>
<td>12,773</td>
</tr>
<tr>
<td>Total Below-The-Line Other</td>
<td>2,431,251</td>
<td>8,894,358</td>
<td>6,403,007</td>
</tr>
</tbody>
</table>

**Display Excluded Amount in Topsheet Description**

Selecting this option will display the actual amount entered in the table.

**Note:** When exporting a Movie Magic Budgeting 7 file to Movie Magic Budgeting, be sure to recalculate a budget; open the Contractual Charges window and click **OK** to ensure the Contractual Charges are properly displayed.
Section 5: Applied Credit

Depending on where a production is being shot, there may be incentives or credits to keep track of to ensure an accurate budget. The Applied Credit tool helps keep track of production incentives that are applied against a budget.

Location of an Applied Credit Row

Applied Credits will be added below the Grand Total. Once a credit is applied, a Net Total will appear to reflect the budget total after the credits.

Inserting an Applied Credit Row

1. Select any row on the Topsheet.
2. Go to Edit or right-click (Mac: CTRL + click) and select Apply a credit.

The Applied Credit window will be displayed.

3. Type the Applied Credit name in the Name field.
4. Add an overall Applied Credit Cap if there is one. The Applied Credit Cap field is used to set a limit on the total amount of the credit available in a particular locale.
5. Add a Discount Percentage if there is one. The Discount % field is used to apply a discount to the overall credit. For example if the credit is being brokered and there is a broker % fee, this field can be used to discount the entire credit by this percentage.
6. Add an account number in the Account Number field which will appear on the Topsheet.
7. Either add a flat amount (labeled as “User”) by pressing the “Include Amount” button.
   Or

8. If a group is qualified to spend lines in a budget, click the “Include Group” button and select a group to be used as the basis for the credit calculation.
9. Click the “Exclude Fringes” to exclude any unqualified fringe benefits from the credit.
Setting a Cap Type

Each line can have its own cap type based on how credit is to be calculated.

10. If there is no cap on the group total or line total, leave the cap type as “None” and leave the cap field blank. Then, enter the percentage of the credit in the percentage field.

11. If there is a cap, determine whether the cap is based on qualified spend or on the total credit amount available. Use the drop-down and select QS for qualified spend cap or CR for credit cap.

For Example:

A production is being shot in a location that returns 15% on a maximum of $500,000 of local qualified labor costs. To apply this **qualified spend cap**, include a group tagged with qualified labor, then enter 500,000 in the cap field. Next select “QS” (Qualified Spend) as the cap type. Finally, enter 15 in the percentage field. The system will calculate the 15% and stop once the qualified spend amount reaches 500,000. Any tagged lines totaling more than 500,000 will be displayed in green in the cap variance column.

The other cap type is a **credit cap**. For example, a production may be shooting in a location that allows a 20% return on all expendable purchases with a limit of $100,000 for the credit. To calculate this credit cap, include a group tagged with expendable purchases. Then enter 100,000 in the cap field and select “CR” (Credit Cap) as the cap type. Finally enter 20 in the percentage field and the system will calculate 20% of that group until it reaches the limit of $100,000.

**In Summary:**

- **Qualified Spend Cap** = Net Total (up to the cap amount) \times \text{percentage}
- **Credit Cap** = Percentage \times \text{Net Total (up to the cap amount)}

12. Click the **OK** key to save.

The newly created Applied Credit line will be displayed below the Grand Total.

**Note:** A specific Applied Credit window may be accessed by double-clicking on the **Applied Credit** line number.

View/Include Applied Credits

Accounts and detail lines can also be included in a particular Applied Credit calculation. This has the benefit of allowing for including a whole account or a selection of detail lines without having to group them.

**Including an Account**

1. Make sure that one or more Applied Credits have been created
2. Go to the Accounts level and select the account to be included in a credit
3. Go to Tools followed by View/Include Applied Credit. A list of credits will appear. Check the checkbox next to the credits in which the selected account is to appear.
4. Close the View/Include Applied Credits window
5. Go back to the Topsheet and double-click the line number of the Applied Credit that was used.
6. The account that was selected and applied to the credit will be shown in the list at the bottom.
7. Enter any credit cap amount
8. Click OK.

Repeat these steps on other accounts or detail lines to include them as well.

The Applied Credit total will reflect the newly included amounts. If not, run a recalculate.

**To Recalculate**

1. Go to the Data menu and select Recalculate.

**Delete a Line Item or Group**

It is also possible to remove a user entry line or Group from the Applied Credit included list.

1. Select the currently included specific line item or Group that now is to be excluded in Applied Credit calculations.
2. Click on the Delete button.

The item or Group will no longer be included in the Applied Credit total. The Applied Credit total will recalculate automatically to reflect the updated total.

The Total Included Amount will be calculated automatically.

3. Click OK to save.
Chapter 4: Accounts Level

Each Category is composed of Accounts. The Accounts show the amount budgeted within a specific account. For example, crew position or equipment package would be an Account within a larger Category. Monetary amounts or other budget information is not entered here. Category Fringe rows (e.g. 1199, 1299) may, however, appear here. Category fringing is a preference setup in Budget Preferences (see Chapter 2: Budget Setup). The rest of the Account Level information will reflect data entered in the Details Level.

Section 1: Accessing the Account Level

To make any changes or additions to the Account Level, first access the correct Account Level for a selected Category.

1. Select a category by clicking on the corresponding listing number button, which will highlight the entire category line.
2. Access the Account Level by one of the following methods:
   • Click the Account icon on the toolbar.
   • Go to Goto and select Accounts.

Additional methods from the Topsheet:

• Click on the down arrow of the Navigation Ball located on the toolbar.
• Go to Goto and select Down into selection.
• Double-click on the line number.

Additional methods from the Details Level:

• Click on the up arrow of the Navigation Ball located on the toolbar.
• Go to Goto and select Up from selection.

Section 2: Entering Account Level Information

1. Tab to or click in a blank Acct No field.
2. Type the Account Number.
3. Tab to or click in the next field, Account Description.
4. Type the Account Name.

Note: The Cut, Copy, and Paste functions in the Edit menu are also available for use in the Accounts Level. To enter Accounts Level information using the Cut, Copy and Paste functions, refer to Chapter 3: Topsheet.
Chapter 5: Globals

Globals are names that represent assigned values used throughout a budget. This feature allows for entering a shortcut letter or code into a budget and the assigned value will be displayed. If a change needs to be made to any Global value while preparing the budget, change the Global and it will automatically be updated every place it appears throughout the budget. This eliminates the need to manually change each value in the budget.

Globals are assigned to Global Groups for easy organization of similar Globals and for quick reference. This is especially useful when there are many Globals in use within a budget.

Section 1: Setting Up Globals

The first step in using Global Groups and Globals is to access the Setup Globals window.

Two Methods:

- Go to Setup and select Globals (CTRL+G).
- Click on the Globals Icon, which is located on the budget toolbar.

At this point, the Setup Global table will open.

The Setup Globals table is divided into two sections:

- **Groups**: On the left is the Global Group Name column; all Globals will belong to a Group. The names of all Global Groups will be listed.

- **Globals**: All Globals reside on the right, assigned to the chosen Global Group.

Globals Toolbar
The Globals Toolbar helps manage Globals and Global Groups with a host of intuitive options.

**Print:** Prints a Global Report

**Print Preview:** Creates an onscreen preview of the printed Global Report

**Save as PDF:** Converts the Global Report into a PDF file

**New Global:** Adds individual Globals to assigned Groups

**New Global Group:** Creates a new Global Group in the Globals Setup window

**Delete:** Deletes a Global from a Group or an entire Global Group

**Move Globals:** Moves Globals within and among Groups

**Merge Global Groups:** Combines the contents of Groups

**Move Up:** Moves up a Global within a Group. **Move Down:** Moves down a Global within a Group

**Display Globals by Value or Name:** Displays Globals throughout the budget by Value or Name

---

**Note:** The Setup Globals table can remain open (floating) while a budget is being used. When moving among Accounts, the window will remain on top of the application.

**Exiting the Setup Globals Table**

A Setup Globals table can be exited out of by clicking the **Close (X)** button located in the upper right-hand corner of the window.

**Global Groups**

The Default Group

This Group is a part of all Globals tables. It may or may not contain Globals depending on the budget template or file used.

For example, if a budget is created from scratch using a blank template, Globals tables will not contain any Globals. If a pre-existing template is used, Globals may be a part of the Default Group.
Adding a Global Group

1. Choose one of two methods:
   - From the Globals table toolbar, click on the New Global Group icon.
   - Place the cursor over a pre-existing Global Group name and right-click (Mac: CTRL + click) on New from the drop-down menu.

   ![New Global Group window](image)

   The New Global Group window will open.

2. Type the name for the Global Group in the Name field and click OK or hit the Enter key.

   The Global Group should now be shown and listed in the Global Group Name column. It will also show in the Globals column.

<table>
<thead>
<tr>
<th>Groups</th>
<th>Global Group Name</th>
<th>Language</th>
<th>Pre-Set</th>
<th>Name</th>
<th>Description</th>
<th>Calculation</th>
<th>Units/Dec</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Example 2</td>
<td></td>
<td></td>
<td></td>
<td>Optional</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

   Globals may now be added.

Adding Globals to a Global Group

The Global name can be a single letter or word abbreviation. It can be assigned to a calculation of a single number or an entire equation. An equation can consist of other Global names and/or numbers. As many calculations and operators as needed can be included. However, it is necessary to use accepted arithmetic operators: +, -, *, / (add, subtract, multiply, divide).

How to Add a Global to a Global Group
1. First, access the Setup Globals window through one of the two methods previously defined.

2. Go to the Global Group Name column and click on the name of the Global Group to add a global. The Global Group Name will be outlined.

3. To add a new Global, use one of two methods:
   - Click on the **New Global** button from the Globals Table toolbar.
   - In the Globals column, place the cursor over the gray box as in the example below and right-click (Mac: CTRL + click) on New from the drop-down menu where the Global is to be added.

A row will be inserted on the Globals side of the table. The cursor will default to the Name field, which will be outlined and ready for entry.

4. Type a name for the Global.

Use single letters, abbreviations, or easily remembered short names for later use in the budget.

The shortcut letter, abbreviation, or short name is what will be typed in a line of Detail during budgeting to insert the assigned value.
5. Select [D] to override the Display By settings for Globals to always display that Global by name.

6. Tab to the next column, **Description**, and type a more detailed description of the Global name (optional).

7. Tab to the next column, **Calculation**, and type a calculation or number for a Global into the field.

   This is the value or calculation that will be employed when that shortcut letter, abbreviation, or short name is typed.

   ![Image of Setup Globals Window]

   **Note:** Calculations for Globals may be combinations of previously saved Globals.

   **Accepted arithmetic operators:**
   
   +, -, *, / (add, subtract, multiply, divide).

8. Type a unit of measurement for a Global in the **Units** column.

   The Unit assigned for the Global will be automatically inserted into the Units field of that line of Detail (e.g. weeks, days, and hours).

9. Type a decimal limit in the **Dec** column and Movie Magic Budgeting 7 will automatically calculate the last column, **Value** (optional).

10. Click **X** to save and exit.

   **Note:** The **In Use** column is non-editable and will record the number of places a Global is used throughout the budget.

### Viewing Multiple Global Groups

The Setup Globals Window gives the option of viewing more than one Global Group at a time.

**Two Methods:**

- Hold down the **CTRL** key while clicking on the Global Groups in the Global Group Name column.
- Drag the cursor over the Global Groups in the Global Group Name column.
The groups selected will be displayed fully expanded, showing all Globals contained within those groups.

- Collapse the views of individual groups by clicking on the minus (-) sign.

**Inserting a New Global to an Existing List of Globals**

1. From the Setup Globals window, go to the Global Group Name column and click on the name of the Global Group where a new Global is to be added.

2. On the Globals side of the table, there is a box with a plus (+) sign. Click on the box to reveal pre-existing Globals.

   Globals will be revealed.

3. Select a row, right-click (Mac: CTRL + click) and select New from the drop-down menu.
4. Enter in data as in the example below:

Moving Globals

There are several ways to move Globals within the Globals table, which may prove useful for categorization purposes.

- Move Globals up or down within a Globals list
- Move Globals from one group to another
- Sort Globals alphabetically for easy reference
- Move Global Groups up or down within the Global Groups list
- Merge Global Groups

These moves can be done within the Setup Globals table.

Move Globals to a Different Position within a Globals List

Move a Global Down within a Globals List

1. From the Setup Globals window, go to the Global Group Name column and click on the name of the Global Group that contains the Global to be moved.

2. Go to the Globals column and click on the box with the plus sign (+) to reveal the list of Globals.
3. Select the row for the Global to be moved. In this example, a Global row will be moved down within a list.

![Global List Example]

4. Click on the **Move Down** arrow from the Globals toolbar to move the selected row down to the desired position.

In the example, the row containing the Global Name “PPP” was moved once.

![Global List Example]

Move a Global Up within a Globals List

1. From the Setup Globals window, go to the Global Group Name column and click on the name of the Global Group that contains the Global to be moved.

2. Select the row for the global to be moved.

3. Click on the **Move Up** arrow from the Globals toolbar this time to move the selected row for the Global Name “P” back up to the first position in the list.

![Global List Example]

The Global Name “P” is back in the first position.

**Note:** After selecting a Globals row to be moved up or down within a list, click on the Move Up or Move Down arrow as many times as needed until it is moved to the desired position in the Globals list.
Move a Global from One Global Group to Another

Globals may be moved from one Group to another for grouping purposes.

1. From the Setup Globals window, go to the Global Group Name column and click on the name of the Global Group that contains the Global(s) to be moved to another Group.

In the example below, the Global Name “TS” (for Total Shoot) has been selected and will be moved from the Default Group to the Example Group.

![Image of Setup Globals window]

2. From the Globals table toolbar, click on the Move Global button.

The Move Globals window should be displayed.

![Image of Move Globals window]

3. If the Group the Global(s) is to be moved to is present in the window, as it is in the example, click the OK button.

Global Name “AD2” is no longer a part of the Default Group.

4. If a Global selected to be moved to another Global Group is not visible, even though the Move Globals window is open, click the down arrow and scan for the needed Global. Then, select from the Global Group list.

5. Example 2 is now visible and any selected Globals will be moved to this Global Group by clicking OK.
Sorting Globals Alphabetically within a Global Group

1. Access the Setup Globals window through a previously defined method.
2. Select the Global Group window through a previously defined method.
3. Click on the plus sign box to reveal existing Globals for the Global Group.
4. Select the Name column.

5. Once Name is clicked, the column will highlight and will sort the Globals alphabetically, as in the example.

6. If it doesn’t, click Name again and the Globals will sort alphabetically.

**Note:** After Globals have been alphabetically sorted, clicking Name again will sort the Globals as they were previously listed.

Sorting Other Globals Columns

- **In-Use:** By clicking on In-Use, the column will highlight and will sort the various Globals by ascending or descending order based on the number of times each has been used throughout the budget.

- **Description:** Sorts text by ascending or descending order

  This Example is in descending order.
• **Calculation**: Sorts Globals by their equations by ascending or descending order as they are positioned within the table.

• **Units**: Alphabetically sorts text by ascending or descending order.

• **Dec**: Sorts numerically by ascending or descending order.

• **Value**: Numerically sorts values by ascending or descending order.
Sorting Global Groups

Manually Sorting Within the Globals Group List

In the example, Example Group 2 will be moved down one position.

1. Access the Setup Globals window through a previously defined method.
2. Select Example Group 2 as is done below:

   ![Screenshot of Setup Globals window]
   - Example Group 2 is now in the last position.

Copying Globals

A new Global may be created from a pre-existing Global by using the Copy and Paste function.

To copy a Global:

1. Right-click at the beginning of the Global line to be copied.
2. Select the Copy option from the drop-down menu that appears.

   ![Screenshot of copied Global]
   - Select the Group where the global is to be pasted.
3. Right-click (Mac: CTRL + click) inside the Group and select the Paste option from the drop-down menu.
The Global will immediately be displayed in the group at the point of insertion.

**Note:** Because each Global must contain a unique name, the copied Global will automatically be named “Copy_ (Global name).” In the example, it is named “Copy1_P” for Prep Weeks. It is recommended that the Global be renamed to avoid multiple Globals beginning with the name “Copy.”

**Merge Global Groups**

The need may arise to merge Global Groups. Using a few steps, this is achievable in the Setup Globals table.

1. Access the Setup Globals window through a previously defined method.

2. From the Globals toolbar, click on the **Merge Global Groups** button.
The Merge Global Groups window opens as in the example below:

3. At the top of the window, select the Group(s) to be merged by checking the appropriate box for the Group(s).

4. At the bottom of the window, click the down arrow to choose the Group the selected Group(s) will be merged into.

In the example, the selected Group is the Example Group.

5. Click OK.

A confirmation window will be displayed and advise that the action cannot be undone.

6. Click Yes to continue. Clicking No stops the merge. In the example, Yes is clicked and the process goes forward.
Example Group 2, containing the Global “SLV” is merged into the other Example Group:

**Global Display**

Select Global Display preferences.

- **Display by Value (default):** If selected, the Global Value, rather than the Global Name, will be displayed in the budget. For example, typing in \textbf{P} for \textbf{Prep Weeks} would result in immediate replacement by the value \textbf{4 weeks}.

- **Selecting the [D]:** This action will set that Global to display by name within the budget and on printed reports.

- **Display by Name:** If selected, the Global Name will be displayed in a budget instead of the Global Value. For example, typing in \textbf{P} for \textbf{Prep Weeks} would enable the Global Name \textbf{P} to remain visible.

**Deleting a Global**

**Important:** Use care when deleting a Global. If it is being used in a Detail Account, the deletion may cause discrepancies in a budget and may prevent a file from being exported to Classic Movie Magic Budgeting.

From the Globals Setup window:

1. Open the Global Group that contains the Global to be deleted.
2. Select the Global to be deleted.
3. Choose one of two methods:

   **Method 1:**
   - From the Globals table toolbar, click on the \textbf{Delete} icon.

   **Method 2:**
   - Right-click (Mac: CTRL + click) on the row for the selected Global.
   - Click on \textbf{Delete} from the drop-down menu.
A message will display confirming that a Global is to be deleted.

4. Click **Yes** to continue.

   The Global selected will be deleted from all locations where it was used.

   If the deleted Global was in use, the budget will now show an error indication, **<<Invalid>>**, wherever the deleted Global was used.

   **Note:** Cells with error indications must be manually updated.
Chapter 6: Fringes

Fringes are additional charges for a contracted price of a budgeted item or service (labor). Typical Fringes include payroll taxes, such as FICA, FUI, SUI, and Workers’ Compensation. As with Globals, if changes need to be made to a Fringe during the budgeting process, edit the Fringe table and changes will automatically occur throughout the budget.

Section 1: Creating Fringes

Two types of Fringes can be created:

- Flat Rate
- Percentage

Begin by accessing the Setup Fringes window.

1. Go to Setup and select Fringes.

The Setup Fringes window is now open. The Fringe Benefits by Percentage table is presented in the top half of the window. The Fringe Benefits by Flat Rate table is presented in the bottom half of the window. The Totals section at the bottom of the window displays the totals of applied Fringes throughout the budget.

Creating a Percentage Fringe

The Percentage table is presented in the top half of the window.

1. Type the Fringe name in the Name field.
2. Click or tab into the next field, Description, and type a short description of the Fringe (optional).
Tab to or click in the next field, **ID**, and type an ID for a Fringe (optional).

**Note:** Assigning a Fringe ID will display the ID in each line of Detail in which the Fringe is used.

1. Click or tab into the next field, **Rate**, and type the Fringe’s Rate per Unit.
2. Click or tab into the next field, **Units**, and type the correct Unit measurement, i.e. Days, Hours.

The Unit measurement typed will automatically be preceded by the word “per.”

3. Click or tab into the next field, **Cutoff**, and type a Cutoff value if needed.
4. Click **OK** to save once all entries have been made and the table is no longer needed for use.

**Note:** Flat Rate Fringes are calculated based on the hourly equivalent of the Unit. If a Unit has no hourly equivalent, such as “Allow,” then the Flat Rate Fringe is calculated as 1 X the Rate. The same calculation should occur for Flat Rate Fringes that have a blank Unit. If the Unit used has an hourly equivalent, then the Flat Rate Fringe should calculate as determined by the Rate per Unit, up to the number of instances defined by the Cutoff value.

**Totals**

This refers to the display of budget fringe totals.

**By Percentage:** This number is the Percentage Fringe total for the entire budget.

- **By Flat Rate:** This number is the Flat Rate Fringe total for the entire budget.

- **Total Fringes:** This number is the Fringe total for the entire budget.

**Editing Fringes**

If Fringe changes need to be made, editing the Fringe table will automatically make the changes wherever the Fringe is applied. This saves making manual changes for each Fringe.

From the Setup Fringes window:

1. Select the Fringe to be edited. The specific field that is to be edited will be highlighted.
2. Type in the new Fringe information.

3. Click OK to save.

The Fringe changes will be immediately applied to a budget.

Section 2: Applying Fringes

From the Details Level:

1. Select the row where the Fringes are to be applied.
2. Access the View/Apply Fringes window.

Two Methods:

- Go to Tools and select View/Apply Fringes.

This will bring up the View/Apply Fringes window.

Select the Fringe(s) to be applied to the Detail row.

**Percentage Fringe**

The small box to the left of a Fringe name indicates a Percentage Fringe. If the small box is filled, it is applied to a Detail row(s). If not, the box will be empty.

Filled = Applied

Empty = Not applied

**Flat Rate Fringe**
The small circle to the left of a Fringe name indicates a Flat Rate Fringe. If the small circle is filled, it is applied to a Detail row(s). If not, the circle will be empty.

**Filled = Applied**

**Not Filled = Not applied**

On the Details Level, the small arrow to the left of each line indicates an applied fringe.

3. Hit the **Enter** key or click the **Close** icon at the upper right corner to save and close the View/Apply Fringes window.

The Fringe modifications will now be displayed in a budget.

**Removing Fringes**

Removing Fringes is done in the same way that fringes are applied to the budget. Remove a Fringe by clicking in the appropriate box to deselect the applied Fringe.

1. Select the row where Fringes are to be removed.
2. Access the **View/Apply Fringes** window.

3. Click on the boxes to deselect the Fringe to be removed from the selected row.
4. Hit the **Enter** key or click the **Close** icon in the upper-right corner to save and close the View/Apply Fringes window.

The **Fringe** will be removed immediately from the selected budget row.

**Setting a Fringe Range**

A Fringe Range is a group of Detail lines, referring to a single entity or individual, to which the same Fringes are applied. The lines are grouped to assure applicable Cutoffs are met and to prevent overstating amounts.

Notice that when Detail lines are first entered, there is a bracket to the left of each line. Brackets indicate a Fringe Range. Initially, each Detail line is its own, individual Fringe Range. A Fringe Range must be created to encompass more than one line of Detail into a Range.

From the **Details Level**:

1. Select the Detail lines to be included in a Fringe Range.

**Two Methods:**
• Hold down the Control key and left-click (Mac: CMD + click) the mouse to individually select/highlight the Detail lines to group into a Fringe Range.
• Left-click and hold the mouse on a Detail line number. Drag the cursor either up or down over the numbers. The Detail line numbers that are dragged over will be selected/highlighted.

2. Select a Fringe Range Method.

   Two Methods:

   1. Click the Fringes icon.

      The View/Apply Fringes window will open.

   2. Click on the Make a Fringe Range button.

      The selected Detail lines will immediately be grouped into a Fringe Range.

      Or

      1. Go to Data, select Make Fringe Range.

      The selected Detail lines will be grouped immediately into a Fringe Range.

**Setting Individual (Removing) Fringe Ranges**

Details that have been grouped into a Fringe Range can be reverted to individual Fringe Ranges.

1. Select the Fringe Range to revert to individual Fringe ranges by using one of the two methods stated above.
2. Select a Fringe Range removal method.

   Three Methods:

   1. Click the Fringes icon. The View/Apply Fringes window will open.

   2. Click on the Remove Fringe Range button.
The selected Fringe Range will be separated immediately into Individual Fringe Ranges.

Or

1. Go to Data and select **Remove Fringe Range**.

Or

1. Right-click (Mac: CTRL + click) to reveal menu.
2. Select **Remove Fringe Range**.

View/Apply Fringes Window Buttons/Selections

- **Clear**: Deselects all Fringes in the **View/Apply Fringes** window, which removes all Fringes from the selected Detail line
- **Sort**: Reorganizes the Fringe listing into alphabetical order

Fringe Range

- **Make**: Groups multiple lines of Detail together to create a Fringe Range, so Fringe Cutoffs can be properly calculated (detailed above in **Setting a Fringe Range**)
- **Remove**: Separates Fringe Ranges into individual Fringe Ranges (detailed above in **Setting Individual (Removing) Fringe Ranges**)
- **Display**: The display drop-down sets how fringe totals are to display in the View/Apply window
  - **Rates**: Shows the percentage that will be applied to a detail line
  - **Total Amounts**: Shows the Fringes’ monetary totals from the entire budget.
  - **View Totals By**: This drop-down shows different total amounts if Display by Totals is selected in the drop-down above
**Budget**: Shows the Fringes' total contribution to the budget

**Category**: Shows the Fringes' total contribution to the selected Category

**Account**: Shows the Fringes' total contribution to the current Account

**Range**: Shows the Fringes' total contribution to the current Range

**Selection** (default): Shows the Fringes' total contribution to the selected line of Detail

- **Close**: Saves and applies the activated Fringes to the budget

**Displaying Fringes in the Budget**

Fringes applied to each Detail line can be viewed by clicking on the **Frin** toggle button in the upper-left of the Details Level. This button shows/hides the dedicated Fringe column. Toggle buttons are further detailed in Chapter 8: Details Level.
Chapter 7: Groups

Grouping lines of Detail allows for including or excluding them collectively from a budget, without actually deleting anything. This is useful for budget comparisons in “what-if” scenarios.

The Groups can be assigned different colors for easy identification.

Section 1: Setup Groups Window

Setting Up Groups

1. Go to Setup and select Groups.

   The Setup Groups window will open.

2. Set the default status for non-grouped Detail lines.

3. Type the Group name in the Name field.
4. Tab to or click in the Description field and enter a short description of the Group name.
5. Tab to or click in the ID field and enter an abbreviation of the Group name (optional).
6. Click on the Color tab.

   The color grid (Pick a Color) window will open.
7. Click on a color block to make a selection.
   
The selected color will be displayed in the Preview.

8. Click **OK** to save a selection.
   
The color will now be displayed in the color tab of a Setup Groups window.

9. Click **OK** to save Group settings.

**Adding New Groups**

From the Setup Groups window:

1. Click on the **Add a Row** icon.

   ![Add a Row Icon]

   A new empty row will be displayed in the Setup Groups window.

2. Complete the same steps detailed for Setup Groups.

**Deleting a Group**

From the Setup Groups window:

1. Select the row or Group to be deleted.

2. Click on the **Delete a Row** icon.

   The selected row will be deleted immediately if it is not in use in the budget. If the Group is in use, a warning will be displayed, detailing the location and number of times it is used.
3. Click Yes to continue with the deletion.

**Budget Calculation**

In the **Groups Setup** window:

**Default status for non-grouped detail lines**

It is possible to opt to set the default for ungrouped detail lines to be included or excluded in the budget.

**Status if there is a Group status conflict**

It is possible to opt to set the default to include or exclude Groups if there are Group conflicts.

**What is a “Group status conflict”?** If more than one Group is applied to a Detail row and one Group is included in budget totals and another Group also applied to the row is not, the behavior for the row needs to be decided. This row may follow the included Group and be a part of the budget’s Grand Total or may follow the excluded Group and not be a part of the Grand Total of the budget.

**Fringe amounts in Group Totals**

It is possible to include or exclude Fringe amounts in the totals for Groups.

**Applying Groups to a Budget**

From the Details Level:

1. Select the row or rows of Details to apply Group properties.
2. Access the View/Apply Groups window.

**Two Methods:**

- Click on the **Groups** icon, located on the budget toolbar.
• Go to **Tools** and click **View/Apply Groups**.

The View/Apply Groups window will be displayed.

3. Select the Group(s) to apply.
4. Hit the **Enter** key or click the **Close** icon in the upper-right corner to save and close the View/Apply Group window.

The row of Details selected to apply to the Group(s) will be displayed in the assigned Group color.

**Including or Excluding Groups**

This function is used to compare different versions of a budget by including or excluding different detail groups.

Excluding a Group

Excluding different Groups helps to see and compare different versions of a budget.

1. Go to **Setup** and select **Groups**.

The Setup Groups window will open.

2. Click to uncheck the **Include in Budget Totals** box for the Group to be excluded.
3. Click the **OK** button to save a selection and close the Groups Setup window.
4. Click **OK** at the warning prompt, detailing the changes that will be made to the budget as a result of the selection.

The excluded Group(s) will be ghosted in a budget and the budget total will reflect the adjusted calculation.

<table>
<thead>
<tr>
<th></th>
<th>Name</th>
<th>Description</th>
<th>Include in Budget Totals</th>
<th>Color</th>
<th>Lines</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Write</td>
<td></td>
<td></td>
<td></td>
<td>320</td>
<td>320</td>
</tr>
<tr>
<td>2</td>
<td>Design</td>
<td></td>
<td></td>
<td></td>
<td>331</td>
<td>230.150</td>
</tr>
<tr>
<td>3</td>
<td>Distant</td>
<td></td>
<td></td>
<td>Red</td>
<td>345</td>
<td>375.284</td>
</tr>
<tr>
<td>4</td>
<td>Group 1</td>
<td></td>
<td></td>
<td></td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>5</td>
<td>Group 2</td>
<td></td>
<td></td>
<td></td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

**Note**: If more than one Group is applied to a Detail line(s), the line(s) will take on the color of the first Group applied.
Chapter 8: Details Level

The Details Level is the third level of a budget where actual costs are entered. Keep in mind that Categories on the Topsheet and Accounts on the Account Level must be created before the Details Level can be accessed. There is a Details Level for each Account listing in the Account Level.

Each line of Detail is a specific component of the account. The sum of all Details represents the costs for the account.

Section 1: Accessing the Details Level

There are several ways to access the Details Level. For more details on navigation, refer to Chapter 1: Getting Started.

From the Topsheet:

- Click on the Detail icon on the toolbar once.
- The available Accounts for the selected Category will be displayed in a pop-up window, covering the Details icon.
- Click on an Account.
- This will bring up the Details Level for the selected Account.

From the Accounts Level:

- Select the Account.
- Click on the Detail icon on the tool bar once.
- This will bring up the Details Level for the selected account.

Goto Account
Knowing the Account number for the following method gives access to the Details Level from any level, including the 4th Level worksheet.

1. Navigate to Goto, and select Go Accounts or click in the Goto field on the navigation bar.

![Goto Account for Example.mdl](image)

2. Enter the Account number in the Account field.
3. Click OK or hit Enter.

Section 2: Entering Details Level Information

1. Tab to or click in a blank Description field.
2. Type in a Name or Description of the expense.
3. Tab to or click in the next field, Amount.
4. Type a number amount or Global.
5. Tab to or click in the next field, Units.
6. Type in a Unit or Unit shortcut.

If a Global is used, step 6 is unnecessary.

7. Tab to or click in the next field, X (quantity).
8. Type in a number for the quantity of the line item (default is 1).
9. Tab to or click in the next field, Rates.
10. Type the detail rate, or use a Global.

Movie Magic Budgeting 7 will automatically calculate the Total of a Detail line as Details are entered.

Note: The Cut, Copy, and Paste functions in the Edit menu are also available for use in the Details Level. To enter Accounts Level information using the Cut, Copy, and Paste functions, refer to Chapter 3: Topsheet.

Formula Maker

Keep the Formula Maker open while entering data into a budget for quick reference and implementation of Globals. All Globals are automatically included in the Formula Maker. This allows for a process of clicking, selecting and pasting to enter a Global into a budget.

1. Click on the Details Level rate cell into which a Global is to be inserted.

   The rate cells are those in the Amount, X, and Rate columns.
2. Go to Tools and select Formula Maker.

Or

Click on the Formula Maker icon on the toolbar.

Or

The Formula Maker will open. Notice that all of the Globals in the current budget are represented in the Formula Maker.

3. Click on the button that corresponds to the Global to be inserted in the selected budget cell.

Assemble a formula by clicking on an operator between two different Globals. For example, to enter a formula that is equal to Weeks multiplied by 9, click on the buttons:

- 9
- *
- w

The display field will read: =9*w

4. Click on the Paste button.

The Global selected/created will be entered into a budget in the selected cell.

**Formula Recall**

The Formula Maker remembers up to ten Formulas or Globals entered at one time. Once the Formula Maker window is closed, the memory is erased. It recalls only the formulas entered while the Formula Maker window was open.
After entering more than one formula with the Formula Maker:

1. Click on the **Formula Recall** button.

   A list of the most recent formulas created will be displayed.

2. Click on the formula to be entered into the budget.

3. Click on the paste button.

**Other Formula Maker Buttons**

1. **Clear Button**

2. **G (Globals) Button** and **F (Formula) Button**

   By clicking on the **Global button**, the “G” will change to an “F” (for **Formula button**) and the information for the Global used in the formula is displayed.
Section 3: Dedicated Detail Columns (Toggle icons)

Clicking on and off of the toggle buttons at the left corner of the Details Level toolbar shows and hides columns that display the components applied to the details.

- **Aggregate % (AGG):** Displays total fringe percentage applied to that line of Detail
- **Fringes (FRIN):** Allows for displaying the Fringes that are applied to a particular line of a Detail
- **Groups (GRP):** Allows for displaying the Groups that are applied to a particular line of Detail
- **Location (LOC):** Allows for displaying the specific Locations to which a particular line of Detail is associated
- **Set:** Allows for displaying the specific Set to which a particular line of Detail is associated
- **Currencies (CUR):** Allows for displaying the particular Currency that is applied to a Detail line

Section 4: Optional Detail Columns

Additional Detail columns are available if budgeting needs require more than the default columns of Description, Amount, Units, X, and Rate. Four optional columns can be accessed: the 2nd, 3rd, and 4th Units, and the 4th Multiplier (rate column).

To access additional Detail Level columns:

**Two methods:**

1. Go to **Setup** and **Budget Preferences**
   
   The Budget Preferences window will open.
2. Check the boxes to display additional columns as in the example above.

The 2nd Units and 4th Multiplier boxes have been checked.

3. Click **OK** to save.

Or

1. Right-click (Mac: CTRL + click) on the Details Level header row.

   A drop-down menu will be displayed.

2. Select optional columns to display, one at a time.

   The 2nd Units and 4th Multiplier columns are displayed and available for data entry.

### Section 5: Note

Movie Magic Budgeting 7 features a Note tool that allows for attaching a message to specific Detail Lines. Refer to Note section in **Chapter 3: Topsheet**.
Chapter 9: 4th Level

The 4th Level offers an additional spreadsheet-style application to further break down information from the Details Level. The 4th Level data can be linked to corresponding data on the Details Level. 4th Level spreadsheets can be created as they are needed. The linkable data ensures that changes made to 4th Level data will be updated wherever they occur throughout the budget.

Section 1: Create a New 4th Level

Three Methods:

1. Click on the **4th Level** button.

   ![Unhide Sheet window](image)

   The Unhide Sheet window will open.

   ![Unhide Sheet window](image)

   The Unhide Sheet window will open.

2. Enter a name for the new 4th Level, in the **Create** field.
3. Click on the **Create** button.

   ![Unhide Sheet window](image)

   The new 4th Level name will immediately be displayed in the list of 4th Levels display area and be ready for access.

   Or

   1. Go to **Worksheet** and select **New 4th Level**.

   ![New 4th Level](image)

   There will be a prompt to enter a name for the 4th Level.
**Note:** The following symbols are not allowed in a 4th Level name: / \ ? * [ ]

2. Click **OK** to save the new name and for immediate access to a new 4th Level.

![Image of a spreadsheet interface]

Or

1. Type **CTRL + 0** (zero).

   The Goto field will be activated with a lavender background.

2. Enter a name for a new 4th Level.

   There will be an advisement that the 4th Level does not exist. It will read, “Do you want to create it?”

3. Click **Yes**.

   With the 4th Level, there is the ability to perform familiar, basic programs from standard spreadsheet applications.

**Note:** To insert additional columns, right-click (Mac: **CTRL + click**) on the column header to view a drop-down menu that will allow for adding additional columns.

### Section 2: Access the 4th Level

1. Choose a method to navigate to a 4th Level.

   **Three Methods:**

   - Click on the toolbar 4th Level button.
   - Go to **Worksheet**, select **Unhide 4th Level** (Alt+4).
   - Go to **Goto** (**CTRL + 0**), enter a **Fourth Level** name.
There will be a prompt to select the 4th Level to see with the Unhide Sheet window.

2. Select the 4th Level to be viewed.
3. Click on the Unhide file button.
4. Click Close to close the Unhide Sheet prompt.

   The selected 4th Level will now be active on the budget desktop.

**Section 3: Using 4th Level**

This level allows the additional break down of information from the Details Level.

For example, information from a transportation category Details Level may need to be broken down further. With the 4th Level, all the drivers may be listed, including their workweeks, salary and total. It is also possible to list the vehicles’ cost for each driver, how long they are being rented and the total.

Entering information to a 4th Level is similar to standard spreadsheet programs.

1. Click on a cell and then enter the desired information into the selected cell.

**Note:** The Cut, Copy, and Paste functions in the Edit menu are also available for use in the 4th Level. To enter budget information using the Cut, Copy, and Paste functions, refer to Chapter 3: Topsheet.

**Autosum**

Autosum quickly adds a group of numerical values. When conducting an Autosum, keep in mind that Movie Magic Budgeting 7 will always total all of the numbers in the column above the cell selected to perform the Autosum. A horizontal line of numbers is totaled by this function only when there is an empty cell or no number field above the cell selected to perform the Autosum.

1. Click into the cell the Autosum is to be displayed.
2. Click on the Autosum button.
The data to be totaled will be distinguished by a broken line.

3. Hit the Tab or Return key.

The Autosum total will display in the selected cell.

**Link 4th Level Data with Details Level**

After conducting 4th Level calculations, there is a simple process that will link the results directly to the corresponding data on the Details Level.

Once a 4th Level calculation is completed:

**Auto Entry**

1. Go to the Details Level.

2. Select, or type in, the multiplier cell into which the 4th Level data is to be inserted.

   Any cell in a multiplier column may be selected:
   - Amount
   - Rate
   - \( \times \)
   - 4th Multiplier (enabled in Budget Preferences, see Chapter 2: Budget Setup)

3. Type an equal (=) sign.
4. Go to the open 4th Level.
5. Select the cell with the desired data.
The selected cell will be distinguished by a highlighted border.

6. Hit **Enter** or tab off of the cell.
7. When the tab of a Details Level Account is clicked on, this action will again bring up the Details Level.

The 4th Level total will be displayed in the previously selected cell.

**Note:**Globals in the 4th Level can be used by typing the equal (=) symbol before the Global name in the cell.

**Manual Entry**

1. Go to the Details Level.
2. Select the cell into which the 4th Level data to be inserted.
3. Type the following formula into the cell:

   ="4thLevelName'!4thLevelDataCellNumber"

Once the cell is navigated off of, the data will be displayed in the selected cell.

For example, the total in this 4th Level example is **129000**. It is in cell **D11**.

The name of this 4th Level is **sample 4th level**.

Navigate back to a Details Level and select the cell in which the Total is to be displayed.

Enter the linking formula in the selected cell. To complete the formula correctly, the following information is required:

- 4th Level Name: **sample 4th level**
- Desired data cell: **D11**

The formula should look like this:

=’sample 4th level'!D11
Once the formula is entered and the cell is tabbed or clicked off of, the total will be displayed in the cell.

The newly linked data that appears on the Details Level will update automatically to correspond with any 4th Level changes made that affect the data.

**Section 4: Copying and Pasting Text between the 4th Level and Details**

A range of cells may be copied and pasted from the Details Level into a 4th Level spreadsheet.

**Copy and Paste a Range of Cells from the Details Level to the 4th Level**

1. Open/Unhide a 4th Level spreadsheet.
2. Go to the Details Level and highlight the range of cells to be copied.
3. Copy the range of cells.

**Two Methods**

- From the menu, select – **Edit + Copy** (CTRL + C).
- Right-click (Mac: CTRL + click) and choose **Copy** from the drop-down menu.

4. Return to the 4th Level and select the row or cell in which to paste the data.

**Note:** For easy navigation between the 4th Level and Details, it is helpful to use the Tab Navigator, located under Options in the File Menu.
5. Paste the range of cells.

Two Methods

• From the menu, select – **Edit + Paste** (CTRL + V / Mac: CMD + V).

Or

• Right-click (Mac: CTRL + click) and choose **Paste** from the drop-down menu.

The range of Details Level cells should paste into the 4th Level spreadsheet.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B: NO. OF ITEMS</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>ITEM</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Computer Rental</td>
<td>1</td>
<td>1</td>
<td></td>
<td>1,500</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Computer Supplies</td>
<td>1</td>
<td>1</td>
<td></td>
<td>1,000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Note:** Even though numeric values may be included in the range of cells copied, all data will only paste as text into the 4th Level. Formulas will not be carried over. However, it is possible to reformat with formulas if necessary.

**Copy and Paste Text from the 4th Level to the Details Level**

It is also possible to copy text from a 4th Level cell to a Details Level cell.

1. Open/Unhide a 4th Level spreadsheet.
2. Highlight the cell to be copied.

Two Methods

• From the menu, select – **Edit + Copy** (CTRL + C)

Or

• Right-click (Mac: CTRL + click) and choose **Copy** from the drop-down menu.
4. Go to the Details Level and select the cell where the pasted data is to be copied.
5. Paste the data into the cell.

Two Methods

• From the menu, select – Edit + Paste (Mac: CTRL + V).

Or

• Right-click (Mac: CTRL + click) and choose Paste from the drop-down menu.

The data should be displayed in the selected cell.

<table>
<thead>
<tr>
<th>Ind.</th>
<th>Agg. %</th>
<th>Description</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td>Equipment Rental</td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td></td>
<td>Super Pee Wee Dolly-1</td>
<td>0</td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td>1</td>
</tr>
</tbody>
</table>

| Total |

Note: Copying and pasting a range of cells from the 4th Level to the Details Level is not supported.

Section 5: Formatting the 4th Level

Assigning unique colors and fonts to different 4th Level lines allows for better detail identification. From font to cell color, the look of the 4th Level can be altered.

The first step is to access the 4th Level formatting options.

From the 4th Level:

Select the 4th Level line or cell that to be reformatted.

The formatting options will display in the menu.

1. Select a formatting option.
Formatting Options

The 4th Level has dedicated formatting options that allow a format to be set.

**Cell Color/Text Color**

Selecting the Cell or Text Color formatting options will bring up a Color selector window.

1. Select a color from the swatches.

   The Preview section in the lower part of the window will display a sample view of the color selection.

2. Click **OK** to save the selection.

   The color selection will be applied immediately to a budget.

**Left/Right/Center Justify**

1. Select the text justification to apply to the selected line or cell.
2. Select Left, Center or Right Justify.

**Two Methods:**

- From the Format menu
- Clicking on the 4th Level buttons

The justification selection will be applied immediately to a budget.

**Date Format**
1. Go to **Format** and select **Number Format**.

   ![Number Format Window](image1)

   The **Number Format** window will open.

2. Select **Date** from the format list.
3. Select a date format from the options provided or type an alternate date format in the **Custom Format** field.

   **Note**: A custom date must be entered in conventional formats, similar to those already provided, i.e. 01/01/2009.

4. Click **OK** to save.

   **Number Format**

   1. Go to **Format** and then select **Number Format**.

   ![Number Format Window](image2)

   The **Number Format** window will open.

   2. Select **Number** from the format list.
   3. Select a number format from the options provided.

   4. Select a **Currency Symbol**.
   5. Select where the **Currency Symbol** is to be displayed. Click **OK** to save.

   **General Format**

   General Format refers only to the 4th Level Number Format. Selecting General Format reverts the selected number to the default format.
1. Select the number to revert to the default format.
2. Go to Format and select General Format.

The number in the selected cell will revert immediately to the default Number Format.
Chapter 10: Shortcuts

The Shortcuts feature allows for applying any Fringe, Group, Location, Set or Currency setting, singularly or in any combination, to any Detail line in a reduced number of steps.

A Shortcut key needs to be defined and assigned properties, Fringe and/or Group for example, to a given key.

Section 1: Creating a Shortcut

From the Details Level:

1. Select the Detail line that contains the settings a Shortcut is to have.

2. Go to Shortcuts and select Create.

The Shortcuts window will be displayed.

3. Retrieve Detail Settings

Three Methods:

- Click on the Retrieve Detail Settings button from the Shortcuts toolbar.

Or
• Right-click (Mac: CTRL + click) on the row number for the highlighted line and select Retrieve Detail Settings - Override Entry.

Choosing this will override the entry on the highlighted line.

Or

• Right-click (Mac: CTRL + click) on the row number for the highlighted line and select Retrieve Detail Settings – Add Entry.

Choosing this will add the new entry at the end of the list.

The row will be entered automatically with settings from the budget row selected earlier.

4. Type a name or letter into the field labeled Name.
   This will be the Shortcut key.

5. Type a short description of the Shortcut in the field labeled Description.
6. Determine if the Shortcut key is to Add to the pre-existing properties of Detail lines where it is applied or Replace these properties.

**Note:** Add is the default. Uncheck the box for Replace.

7. Click on the Close button to store a Shortcut.
Section 2: Create Shortcuts from Scratch

1. Go to Shortcuts and select Create.
2. Add a row.

Two Methods:

- Click the Add a Row button to add a new row from the Shortcuts toolbar.
- Right-click (Mac: CTRL + click) on the highlighted line and select Insert Row.

3. Type a letter or short combination of letters into the field labeled Name. This will be the Shortcut key.

4. Type a short description of the Shortcut in the field labeled Description.
5. Determine if the Shortcut key is to Add to the pre-existing properties of detail lines where it is applied or Replace these properties.
6. Create Detail Settings

Two Methods:

- Click the Create Detail Settings button from the Shortcuts toolbar.
- Right-click (Mac: CTRL + click) on the highlighted row and select Create Detail Settings.

The window will expand to include the Detail Settings listing at the bottom. Two buttons will be displayed at the top of the newly expanded window:

The expanded portion of the Shortcuts window displays all of the entries that exist in the setup tables for Fringes, Groups, Locations, Sets, and Currency.
7. Select the settings to be included in the shortcut being created.

   Multiple selections can be made in the Fringe and Group settings. Hold the Control key down while clicking with the mouse to make more than one selection. Only one selection can be made for the Location, Set, and Currency settings.

   The Shortcut created will be displayed as part of the Shortcuts list.

8. Click Accept The Selections From List to complete the shortcut
9. Click Close to save.

Section 3: Applying Shortcuts

Using Shortcuts in the Details Level during budgeting is more efficient than individually selecting the settings.

On the Details Level:

1. Select the Detail line where a Shortcut is to be applied.
2. Apply the Shortcut

Two Methods:

• Mouse method:
  1. Go to Shortcuts and select Apply.
  2. Select the Shortcut from the list.

• Keyboard method:

  1. CTRL + M + Name (Mac: CMD + M + Name) of Shortcut and hit Enter key

   Note: When using the Keyboard method, the Goto field on the navigation bar becomes active and turns to a khaki shade of green. This is where the shortcut name is to be typed. Then, hit the Enter key.

   The settings assigned to the Shortcut will be applied to the selected Detail line.

Section 4: Deleting a Shortcut

From the Shortcut window:

1. Select the Shortcut to be deleted by clicking on the listing number.

2. Two Methods:

   • Click on the Delete Row button from the Shortcuts toolbar.
• Right-click (Mac: CTRL + click) on the highlighted row and select **Delete Row**.

The selected Shortcut will be deleted immediately.

**Section 5: Shortcuts Report**

Refer to **Chapter 16: Print Setup** and **Chapter 17: Generating Reports** for complete details on creating and printing a Shortcut report.

**Print Preview**

Click on the **Print Preview** button to view an onscreen image of the Shortcuts report when printed.

**Print**

Click on the **Print** button to print a Shortcuts report.

**Converting to PDF**

Click on the **PDF** button to convert the Shortcuts report to a PDF file. Converting the report to PDF allows for it to be sent via email.
Chapter 11: Recalculate

Movie Magic Budgeting 7 automatically recalculates a budget periodically. However, a recalculation may need to be run when many calculations and changes are conducted at once.

Additionally, it is recommended that a recalculation be run whenever a budget is imported to Movie Magic Budgeting 7 from an external source (e.g., EP Budgeting or Classic Movie Magic Budgeting) or when a file is exported to Classic Movie Magic Budgeting.

From a budget:

• Go to Data and select Recalculate.

The budget will be recalculated immediately to incorporate the latest changes.
Chapter 12: Library

The Library allows for storing budget data to be used elsewhere in the same or a different budget. This feature also saves the detailed portion of a particular data entry. For example, if a Topsheet Account listing is stored in the Library and it is retrieved on another budget, that entire Account listing will be displayed for all levels, including the corresponding information on the Details Level. In addition, some data from Setup tables will be stored, limited to the properties applied to the Detail lines of the Library entry.

Section 1: Library Functions

Open Library Manager

First, open the library Manager by going to Library in the menu bar and select Show Library Manager. The Library manager will display. On the left side is a list of all the libraries that have been loaded into the application. Once a library is selected, the contents of that library are displayed on the right.

Note: The library files are stored as separate files on a computer. They are independent of the budget file that is being used. This allows for the use of the library across budgets and computers.

The first step in using the Library is to create a new Library.

1. Open the Library Manager by going to the Library followed by Show Library Manager.
2. Click the New button in the lower-left side of the Library Manager window.
3. Choose a location to save the library and name it.
4. Click Save.

The new library will open in the pane on the left.
Open an existing Library

To open an existing Library:

1. Open the Library Manager by going to the Library tab in the menu bar, followed by Show Library Manager.
2. Click the Open button in the lower-left side of the window or select Library followed by Open Library.
3. Navigate to where the library is stored in the computer.
4. Click Open.

The library will be displayed on the left side of the Library Manager.

Extract Data

To Extract data from the budget into a library:

1. Click the row number(s) to select a populated row(s).
2. Make sure a Library is selected in the left pane of the Library Manager.
3. Press the Extract button in the lower-right side of the Library Manager window or select Library in the menu bar and choose Extract Data in the menu.
4. Enter a name for the data being extracted and click OK.
5. The data will appear in the right pane of the Library Manager window.

6. Close the Library Manager if finished.

Insert Data

To Insert Stored Data from the Library:

1. Select the budget line in which the extracted data will be inserted.

Note: Data in the library can only be inserted at the appropriate level of the budget. If a library entry was extracted from the Topsheet, it can only be inserted at the Topsheet. This also applies to data extracted from accounts and detail lines.

2. Go to Library Manager and select the library from the left pane and data from the right pane.
3. Click the Insert button at the bottom right of the window or select the Library menu and choose Insert Data.

The extracted entry will be inserted after the selected line.

**Deleting Library Entries**

1. Access the **Library Manager**.
2. Select the entry to be deleted.
3. Click the Delete button at the bottom of the window.

**Note:** Clicking the delete button under the left pane will delete the library from the library manager, but it will not delete the library file from your computer. So the library is not lost and can be re-opened at a later time. But deleting an entry from a library will permanently remove that entry from the selected library.
Chapter 13: Budget Comparison

Movie Magic Budgeting 7 allows for comparing several different budgets at once. Budgets may also be compared against Vista Cost Reports (*.vis) at the Accounts Level.

1. Go to File and select Budget Comparison.

   The Create Budget Comparison Report window will open.

2. Select a budget to compare and click the Add button.

   The budgets will be added to the Budget List.

3. Select another budget (to compare the original budget with) and click the Add button.

   Continue adding budgets to the Budget List until satisfied with the number of budgets selected for comparison.

   Note: To remove a budget from the Budget List, select the budget to be removed and click on the Remove button.

4. Select the type of report with which the Budget Comparison is to be generated.

   • Variance
   • Average
   • Both

5. Select how the Budget Comparison report is to be viewed.

   • All Accounts: Displays a complete Budget Comparison, including all Accounts
   • Topsheet: Displays only a Topsheet Budget Comparison (unavailable on Vista Cost Report vis) comparisons
Account: Displays a Budget Comparison of specific Account numbers

6. Click OK to generate the Budget Comparison report.

It will take Movie Magic Budgeting 7 a few moments to generate the Budget Comparison.

Budget Comparison Report Buttons

- **Print**: Click the Print icon to print the current Budget Comparison.

- **Print Preview**: Click the Print Preview icon to view an onscreen preview of what the printed Budget Comparison will look like.

- **PDF File Conversion**: Click the PDF icon to convert the Budget Comparison to a PDF file.

- **Page Setup**: Click the Page Setup button to access the Page Setup window. Here, margin size can be determined.
• **Edit Header/Footer**: Click the **Edit Header/Footer** button to access the Setup window to customize a header/footer for the Budget Comparison Report.

Comparing to Vista Cost Reports

From the **Create Budget Comparison Report** window:

1. Select **Vista Cost Report (*.vis)** from the **Files of type** options.

2. Select the **Vista Cost Report** to be compared.

3. Select either:
   - **EFC** to choose an Estimated Final Cost .vis file
   - **Total Cost Plus Commit(ments)** .vis file.

   Comparisons are available at the Account Level only for both types of .vis files.

4. Continue as if comparing regular budget files, a process detailed above.
Chapter 14: Copy and Paste Between Two Budgets

Movie Magic Budgeting 7 gives users the ability to copy and paste from one Movie Magic Budgeting 7 file to an entirely different Movie Magic Budgeting 7 file. It is possible to copy and paste data between budgets at the same Level. Meaning, it is possible to copy from the Topsheet of one budget and paste that information onto the Topsheet of another budget. This is also true for the Account Level; it is possible to copy from the Accounts Level of one budget and paste to the Accounts Level of another budget. Similarly, the copied data from the Details Level of one budget would be pasted to the Details Level of the destination budget.

**Note:** If the destination budget already contains Globals, the Paste function will be disabled if there are any duplicate Globals. Rename any duplicate Globals before attempting to copy and paste between budgets.

Section 1: Copy and Paste Between Budgets at the Topsheet Level

To copy and paste between budgets from the Topsheet:

1. Open the budget from which the information is to be copied.
2. Open the second budget into which the information is to be pasted by selecting either New Budget (a template) or Open File (an existing file) from the File menu.
3. With both budgets now open, access the Window menu and select Arrange.

The Arrange Window will open.
4. Select the **Arrange Budgets** desktop option and choose the preferred view from the **Action** options. **Horizontal** is recommended to view right scroll bars.

Both budgets will be displayed in Horizontal view.

5. Select the account to be copied by clicking in the **Account Number** field.

6. Right-click (Mac: CTRL + click) on the line number and select **Copy Row** from the drop-down menu.

7. Select a destination row in the second budget.

8. Right-click (Mac: CTRL + click) and select **Paste Row** from the drop-down menu.
9. The copied row will be pasted above the row selected.

To remove the dotted lines around the pasted cell, return to the line that was originally copied. Click on this line and press the **Escape** key.

**Best Practice Tip:** Always clear the dotted lines by clicking on the line that was originally copied and pressing the **Escape** key. This will prevent the clipboard from accumulating unnecessary data.

**Note:** When copying and pasting between budgets, data from the related lower Levels will also be copied. For example, if a copy is performed using the Topsheet, related data for the Accounts and Details Levels will also be copied. The settings applied to Detail lines will copy over and the appropriate Setup tables will be populated accordingly. This applies not only to Fringes and Globals, but also to Currency, Groups, Locations, Sets, and Units.

**Section 2: Copy and Paste Between Budgets at the Accounts Level**

To copy and paste between budgets from the Accounts Level:

1. Open the budget to copy from.

2. Open the second budget where the copied information is to be pasted.

3. Arrange the budgets as defined under **Section 1: Copy and Paste Between Budgets at the Topsheet Level**.

4. Go to the Accounts Level and select the Account to be copied by clicking in the **Account Number** field.

5. Right-click (Mac: CTRL + click) on the line number and select **Copy Row** from the drop-down menu.

6. Select a destination row in the second budget.

7. Right-click (Mac: CTRL + click) and select **Paste Row** from the drop-down menu.
The copied row will be pasted above the row selected.

**Note:** When copying from the Accounts Level, data from one level down, the Details Level, will likewise be a part of the paste process at the destination budget. Any Detail settings used will come across and be added to the appropriate setup tables.

**Section 3: Copy and Paste between budgets at the Details Level**

To copy and paste between budgets from the Details Level:

1. Open the budget to be copied from.
2. Open the destination budget where the copied Details information is to be pasted.
3. Arrange the budgets as defined under **Section 1: Copy and Paste Between Budgets at the Topsheet Level**.
4. Go to the Details Level and select the row to copy by clicking on the row number.
   
   **Note:** If copying multiple rows, click on the row number for the first row and select subsequent rows by holding down the mouse and dragging down for all rows wanted.

   **Note:** Nonconsecutive rows can be copied by selecting the first row, holding down the Control key (CMD key on the Mac), and then choosing other rows as needed.
5. Right-click (Mac: CTRL + click) in the row number column and select **Copy Row** from the drop-down menu.
6. Select a row at the Details Level of the destination budget.
7. Right-click (Mac: CTRL + click) and select **Paste Row** from the drop-down menu.

   The data should be copied over, including all related settings.

Copying and pasting data between budgets, whether from the Topsheet or Accounts and Details Levels, saves data entry time. After data has been copied and pasted to the destination budget, modifications can be made to customize it.
Chapter 15: Create a Sub Budget

Movie Magic Budgeting 7 allows for creating several views of the same budget using existing currencies, locations, groups or sets. The **Create Sub Budget** feature is a quick and easy method to see a new budget version without affecting an original budget. Through the process of filtering, it is possible to specifically choose what is to be included in a sub budget. For example, a budget may be viewed by isolating a specific currency or location cost without altering the original budget.

A sub budget is a fully functioning budget and can be edited, modified, and updated just as an original budget would be. It is also possible to print views and save new budgets.

**Note:** Changes made to a sub budget will not be reflected in the original budget.

1. Go to **File** and select **Create Sub Budget**

The **Create Sub Budget** window will display, listing all of the Currencies, Locations, Sets and Groups that have been set up previously in the respective tables for the original budget.

**Section 1: Include Notes**

Located in the bottom left of the window, as a default, the box for Include Notes is checked and any Notes created in the original budget will be included in the sub budget. Uncheck if Notes are unwanted. A complete explanation of the Notes feature is found in Chapter 3: Section 3: Note – Attaching a Note.

**Section 2: Include Fringes**

There is the choice to include Fringes in a sub budget by checking this box. The default does not include fringes.

1. Once it is decided what is to be included in a sub budget, proceed by de-selecting and selecting the properties from the four columns for **Currency**, **Location**, **Set** and/or **Group**.
To make single selections:

• Click on each listing.

To make multiple selections:

• Hold down the Control key.
• Click on the listings to be selected.

To make grouped selections:

• Hold down the Shift key.
• Click the first listing and the last listing of the group to be selected.

The two listings clicked on, and all the listings in between, will be selected.

See the example below of selections for a sub budget:

![Selections Example](image)

In this sub budget view, the following will be displayed:

• Currency = United States
• Locations = Las Vegas
• Sets = Construction
• Groups = Construction
• Notes should be included
• Fringes should be included

2. Click **OK**.

![Ok Cancel Button](image)

The newly created sub budget view will display immediately.
Sub budgets may be renamed and saved for future use.

**Note:** Once a sub budget has been created, it may be necessary to edit report headings. Go to Chapter 17: Section 7: Edit Header/Footer.
Chapter 16: Find Tool

Movie Magic Budgeting 7’s comprehensive Find Tool provides a quick and convenient method for finding specific budget data at any Level.

There are several ways a search may be conducted:

- Text/Numeric
- Fringe
- Group
- Location
- Set
- Currency
- Contractual Charge

Section 1: Main Functions

Access Find

Go to Edit and select Find.

Conducting a Text/Numeric Find

With the Text/Numeric tab active:

1. Type the text or numerical data to find in the Find What field.
2. Select the Options to match with the results.
3. Select the Columns in which to search.
The following steps involve fields in the Controls portion of the Find window.

4. Select the **Scope** of the search.

5. Select where to begin searching from in a budget by choosing a **Direction**.

6. Select the **Origin** in which to conduct the search.

7. Click the **Find** button to begin searching.

The budget level with the searched-for data will be displayed as the active level, with the information highlighted.

The **Recent Searches** field at the bottom of the Find window will display a list of searches conducted.
Conducting a Fringe Find

The steps to conducting a Fringe Find are the same steps used to conduct finds in the Group, Location, Set, Currency and Contractual tab categories, except for Text/Numeric (detailed above).

With the Fringe tab active:

1. Select the Fringe(s) to find from within the list.

Notice that the Replace With options are inactive. These options are active only when conducting a Find and Replace (detailed in Conducting a Text/Numeric Replace).

2. Select the Scope to apply to the search.
3. Select the point of Origin for the search to begin.
4. Select the Direction where the search is to be conducted.
5. Click the Find button to begin the search.

The budget level with the searched-for data will be displayed as the active level, with the information highlighted.

Note: Follow these same steps for conducting Group, Location, Set, Currency, and Contractual Charge Finds.

Find Next

This function allows for a search to be conducted with the same search parameters as the previous search.

1. Go to Edit and select Find Next.

The highlighted data will be brought up immediately.
Additional searches for specific data may be conducted until all instances have been found. Movie Magic Budgeting 7 will advise of such with this message:

Click OK or the exit button to closes the window.

Section 2: Find and Replace

Movie Magic Budgeting 7 allows for finding and replacing budget data in just a few quick steps.

Access Find and Replace

Go to Edit and select Find and Replace.

Conducting a Text/Numeric Replace

With the Text/Numeric tab active:

1. Type the text or numerical data that needs to be found in the Find What field.
2. Type the text or numerical data to then replace it with in the Replace With field.
3. Select all search parameters as if conducting a regular find, detailed above in Conducting a Text/Numeric Find.
4. Click the Find button to begin the search.

The searched-for data will be found and highlighted. A Replace prompt window will be displayed.
5. Verify the decision to replace the old data with the new data.
6. Click the **Replace** button to replace the current highlighted data on a budget with the new data (or hit the Return key on the keyboard).

This section may be skipped if no individual selection needs to be replaced.

**Replace All** replaces all of the data that matches the search criteria with the new data.
Chapter 17: Print Setup

Movie Magic Budgeting 7’s extensive Print Setup menu features a variety of print options in addition to generating reports.

Access Print Setup

Go to File and select Print Setup.

The Print Setup window will open.

Note: The Details and Topsheet report options will be selected (checked) the first time the Print Setup window is accessed. These are the default report options. Clicking on the Restore Defaults button will always leave only the Topsheet and Details report to be printed. The Topsheet report will print first.

Section 1: Select Report(s)

Specify the data to be displayed in a print report by checking the data categories to include.

Note: The 4th Level selection is both a check box and a button. Click this button to view a list of existing 4th Level files. Select the files to be included in the printed report.
Section 2: Select Additional Column(s) to Print

A variety of additional columns can be printed.

**Note:** The Currency column will always print with the budget in a multicurrency budget. This is a default option that cannot be changed.

Section 3: Budget Data Option

Specify the budget data to be printed.

**Display Currency by Value**

Check the **Display Currency by Value** box to have the currencies displayed by actual rate of currency, rather than by currency abbreviation.

**Suppress Excluded Group**

The **Suppress Excluded Group** box will be checked as the default to hide excluded Groups from the Details Level of the printed budget.

Uncheck the **Suppress Excluded Group** box and excluded Groups will print in a Details Report.

The word “**Excluded**” will be displayed in each row in the Subtotal column for an excluded row.

**Print Fields Equal to 1 or 0**

The values 1 or 0 will print in all cells/fields of rows where they have been entered as part of a Details Report. This generally applies to zero subtotal rows where 1 and 0 are the only values entered in the multiplier fields of **Amount**, **X**, **Rate** or **Rate 4** (optional field).

Uncheck **Print Fields Equal to 1 or 0**.
Example report of the same Account would look like this:

<table>
<thead>
<tr>
<th>Acct No</th>
<th>Description</th>
<th>Units</th>
<th>X</th>
<th>Rate</th>
<th>Subtotal</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>2195</td>
<td>2nd 2nd Assistant</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Prep Local</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Sheet Local</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Wrap Local</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Additionally, there are three budget data options for printing reports:

- **Print All Account(s):** All accounts will print for the selected reports. This applies to all selected reports whether Topsheet, Accounts and/or Details.

- **Suppress Empty Account(s):** Accounts containing no Detail Level data will not print. This applies to all selected reports associated with these accounts, whether Topsheet, Accounts and/or Details.

- **Suppress Zero Total Account(s):** Accounts containing Detail Level data, but equal to zero, will not print. This applies to all selected reports associated with these accounts, whether Topsheet, Accounts and/or Details.

### Section 4: Print Account Option

Print Account Options allows for selecting the range for the print job to be initiated.

- **All**
  - Selecting **All** will include all Accounts in a report.

- **Account Range**
  - Define an **Account Range** to print only those Accounts in a budget that fall within the specified range.

  1. Select the **Account Range** radio button.
  2. Enter the Account number from where the printed range will start in the **From** field.
  3. Enter the Account number where the printed range will end in the **To** field.

  For example, to print an Account Range from 2300-2302, enter the following:
The printed report will reflect only the Account Range entered and any other Print Setup options.

**Note:** After closing the Print Setup window, the Print Account Option will automatically return to the **All** default setting.

### Account Selection

Define a specific Account to print by selecting **Account Selection**.

1. Select the **Account Selection** button.
2. In the provided field, type in the Account number or numbers to be printed. For multiple Account numbers, separate each number by a comma and space.

The printed report will reflect only the specified Account numbers.

**Note:** Pagination in the Topsheet and Accounts Level is not supported when requesting a range or selection of Accounts. For further explanation of pagination, see **Chapter 19: Budget Desktop Options: Section 3: Paginate**.

### Section 5: Format Option

The Format Option is the area of the application to specify how a report’s characteristics are to appear when printed.

#### Text Wrap

Allows text fields to resize so all of the text is seen.

**Note:** By selecting **Text Wrap**, pagination will be effected.

#### Fit Column Widths to Page

Resizes the column widths and scales the font to fit on the page horizontally.
Note: If the Fit Column Widths to Page option is unchecked, adjust the column widths in the displayed worksheets to change column widths in the printed report.

Page Break

Select how the budget report printout is to be divided:

- Per Report
- Production Level
- Category

Select a Page Break

1. Click on the field next to the words: **Page Break**.

   ![Page Break](image)

   A drop-down menu of Page Break options will open.

2. Select a Page Break option.

Section 6: Page Setup

Determine the look of the report’s printed page by selecting such characteristics as paper size and margins.

1. Click on the **Page Setup** button.
The Page Setup window will open.

2. Make Page Setup selections:
   • Paper Size and Source
   • Orientation
   • Margins

3. Click OK to save.

Section 7: Edit Header/Footer

The Edit Header/Footer button accesses the window where a report’s layout is determined.

Layout

Determine the layout of a report by selecting which layout to edit. Then, make edits to the Center, Left, and Right fields in the Report Setup window.

Setup Text

Select the layout text to edit by clicking on the Edit Header/Footer button and choosing either Topsheet Only or Report from the drop-down menu.
Topsheet Only

Choosing **Topsheet Only** opens the **Topsheet Header, Footer** window.

Report contents are generally divided into three columns: **Center**, **Left**, and **Right**. There is a field for each column in the Report Setup window. The data that appears in the fields is the column data in the layout selected.

On the Topsheet, there can be a total of only 11 lines, including spaces. The application will display a warning message if this number is exceeded.

Click **OK** or the **Exit** button to eliminate the warning message. Decide which lines to remove from the Topsheet Header to fit within the limit.

**Report**

Choosing **Report** opens the **Report Header, Footer** window where the information to be printed in the header and footer of all reports can be set up.
There is a limit of two lines (including spaces) that can be entered for the Report Header, Footer. If the limits are exceeded, a warning message will display which is similar to that of the Topsheet Header.

By selecting **Header**, the information that is in the Header report will display in the fields below.

**Inserting Text**

1. Click in the column field into which the additional information will be inserted.
   - Left
   - Center
   - Right

Click on the **Insert Text** button to reveal a drop-down menu with a list of text options.

2. Click on the **Insert Text** button to reveal a drop-down menu with a list of text options.

![Insert Text Dialogue Box]

**Note:** Page # will not be active when setting up the text for the Topsheet.

Each option, when chosen, displays an HTML tag for the information it represents.

**Note:** The Topsheet Header has a limit of 11 lines, including spaces.

![Topsheet Header Dialogue Box]

In the example above, the current date will be displayed immediately following the listing of Date in the center column of a report.

1. Click **OK** to save when finished inserting text.
**Note:** Text entered in the Report Header sections will also print on the Topsheet. Remember this to avoid duplicating text on reports.

![Topsheet Report](image)

**Note:** Text entered in the Footer sections for the Topsheet will print only on the first page of the Topsheet report. If a Topsheet report extends to additional pages, text set up in the Footer section of the Report Header will be displayed on these pages.

![Example Topsheet Report](image)

**Note:** Text entered in the report Footer will print on all reports, but not on the first page of the Topsheet.

### Section 8: Printing Font

View the font name and size that the report will be printed in. It is possible to select a different font size.

Click on the **Font Size** button.
The Printing Font window will open.

To change the font size:

1. Click on the arrow next to the font size number to reveal a drop-down menu of additional sizes.
2. Select a font size.

**Note:** To change font style, go to the Budget Preferences window. See Chapter 2: Budget Setup, Section 1: Budget Preferences.

**Section 9: Print in Color**

To print a budget report in color, select the Print in Color option.

**Section 10: Print Preview**

Movie Magic Budgeting 7 allows for viewing reports before printing.

**To Print Preview**

From the Print Setup window:

1. Click the Print Preview icon.

The onscreen reports display exactly how the reports will look when printed.

**Note:** Page numbers may not display exactly as they will print.
Print Preview Options

It is possible to go directly to Print from Print Preview or a report can be saved as a PDF file. It is also possible to enlarge or shrink the onscreen report view size in percentage increments.

To Enlarge or Minimize Onscreen Report View

1. Click on the 100% button.

This will reveal a drop-down menu of viewing size options.

2. Select the percentage at which to view the report.

The onscreen view will reflect the percentage size selection immediately.

To Print

Click on the Print icon.

To Save as PDF

1. Click on the PDF icon.
2. Select the location where the PDF report is to be saved.
3. Rename the report.
4. Click **Save**.

The report is now saved as a PDF file and can be accessed, viewed, printed, and emailed.

**To Close Print Preview**

Click the **Close** button.
Chapter 18: Generating Reports

One of the last steps in creating a budget is to generate reports. Movie Magic Budgeting 7 allows for creating specific reports, ranging from the Topsheet and tables to the dedicated columns in the Details Level.

Section 1: Edit Report Layout

It is possible to determine the layout for a report. Access the Edit Header/Footer window to change the report layout.

**Access Header/Footer Setup**

1. Go to File and select Print Setup.
2. Click the Edit Header/Footer button.

Select the layout text to edit by clicking on Edit Header/Footer and choosing either Topsheet Only or Report from the drop-down menu.

**Layout**

Determine the layout of a report by selecting which layout to edit and then make edits to the Left, Center, and Right fields in the lower half of the Report Setup window. Refer to Chapter 16: Print Setup for more detailed information.

Section 2: Printing Reports

After completing the report layout steps detailed above, select the reports and print.

1. Go to File and select Print Setup.
The Print Settings window will open.

2. Select the report(s) to be printed.
3. Select any additional columns from the Details Level to be printed.
4. Select All or input an Account Range to be included in a report.
5. Click on the Print icon to print.

Note: If printing by Account Range, the Print Account option will revert to the All default setting once the Print Setup window is closed and reopened again.
Chapter 19: Budget Desktop Options

Movie Magic Budgeting 7 offers a variety of viewing options to personalize the look and use of a budgeting desktop. These can be found in the Options menu of the Movie Magic Budgeting 7 toolbar.

To access the Movie Magic Budgeting 7 options:

1. Go to **Options** on the toolbar.
   - A drop-down menu will be displayed.

2. Select the option to be edited.

Section 1: Password Protection

Protect budgets by enabling the **Password Protection** feature. This feature allows for assigning passwords that must be correctly entered to access or save changes to budgets. Individual passwords must be assigned to each budget, one at a time. However, it is also an option to assign the same password for different budgets.

**Note:** It is very important to remember a password. If the password is lost or forgotten for a protected budget, it will no longer be available to its user. Movie Magic Budgeting 7 is unable to retrieve protected budgets.

**Assigning a Password**

Assigning a password to a budget prevents it from being accessed without the correct password.

1. Open the budget to assign a password to it.
2. Go to **Options** and then select **Security**.

   The **Security** window will open.

3. Type a password in the first field (labeled: **Enter Password**).
4. Re-enter the password in the second field.
5. Click **OK**.
6. Save the budget for the new security settings to be effective.

   The current budget will now require the password to be accessed.
Read-Only Permission Password

A Read-Only Permission password prevents changes from being saved to the budget without entering the assigned password. However, a Read Only Permission password still allows a budget to be opened and read without the password. To keep the budget from being opened, assign a password, as outlined above in Assigning a Password.

To assign a Read Only Permission password:

1. Open the budget to assign a password to it.
2. Open the Security window.
3. Check the Read Only Permission box.
4. Enter and re-enter a password in the appropriate fields.
5. Click OK.

Accessing a Protected Budget

1. Begin accessing a protected budget.
2. A password request prompt will open.
3. Enter the previously assigned password in the field provided.
4. Click OK.

If the password is correct, the selected budget will immediately open. If the incorrect password is entered, an error message will be presented. Click OK to try again.

Accessing a Password-Protected Read-Only Budget

Access a Password-Protected Read-Only budget as if it were an unprotected budget. Be aware that any changes made to the budget will not be saved. To save any changes made to a Read-Only budget, remove the password protection as outlined below in Removing a Password.

1. Access the Password-Protected Read-Only budget.
The following message will be displayed:

![Read Only Budget Warning](image)

2. Click **OK** to open the budget.

   The budget will be denoted as **View-Only** at the bottom of the budget:

   **Removing a Password**

   1. Open the budget that is to have its password removed.
   2. Go to **Options** and then select **Security**.

   The **Security** window will open with the **Remove Password** already selected as a default because the budget is currently password protected.

   ![Security Window](image)

   3. Type the current password in the first field (labeled: **Enter Password**).
   4. Re-enter the password in the second field.
   5. Click **OK**.

   **Note:** A budget must be saved for the password removal to take affect.

   **Change Password**

   To change a password, remove the current password prior to assigning the new one.

   1. Remove the current password (see above in **Removing a Password**).
   2. Assign the new password (see above in **Assigning a Password**).

**Section 2: Save Reminder**

Outlined above in **Chapter 1: Getting Started**.

**Section 3: Paginate**

Paginate finds and lists the page number for the Details Level data as it would be numbered if printed. The page number displays in the Topsheet and Accounts Level **Page** columns, next to the **Original** column.

Paginating a budget helps locate Details Level data in a large, printed budget.
To paginate a budget:

1. Go to **Options** and select **Paginate**.

Numbers will display in the **Page** column of a Topsheet and Accounts Level for each line item. These numbers represent the page numbers of the line item’s Details Level location. The above examples are of a Topsheet before and after pagination.

**Note:** The paginate numbers do not refresh automatically to reflect changes in the budget. To ensure more accurate pagination when using the numbers for reference, be sure to Paginate each time changes are made to a budget.

**Section 4: Single Document**

This option limits the number of open documents on a budgeting desktop to one at a time. This also affects the tab navigation. Only one tab may be active at a time if the **Single Document** option is selected. However, the 4th Level will continue to open with separate tabs with the Single Document option selected. To have more than one document open on a budgeting desktop at the same time, uncheck this option.

**Section 5: Tab Navigation**

This option hides or reveals the Tab Navigation, located at the bottom of a budgeting desktop. To hide the tab navigation, uncheck this option. Tab Navigation will not function if the **Single Document** option is selected.
Section 6: Budget Statusbar

This option hides or reveals the Budget Statusbar at the top of a budgeting desktop. The Budget Statusbar displays information about active documents on a budgeting desktop. Each display refers to an open document. Click the Reset button to clear the Session and Change amounts.

The first part of the Statusbar displays the current active documents that are on a budgeting desktop.

The second part of the Statusbar displays the current Session amount, the Change amount and the Reset button.

- **Session Amount**: The total amount of dollars by which the budget has been changed since it was opened or re-opened or since last being Reset
- **Change Amount**: The actual dollar amount of the most recent change
- **Reset**: Clears both the Session and Change amounts

Section 7: Scroll Wrap

This option allows for easy, continuous movement from one row of a budget to the next. With the Scroll Wrap option selected, the Tab or right arrow key will move focus from the last field of a row to the first field of the next row in the worksheet or table. When in the
last field of the last row, click the **Tab** or **right arrow** key. A new row is created and new information can be entered immediately.

**Note:** Use the **Enter** key within any field in a worksheet or table to move down to the same field in the row below. When in the last row of a worksheet or table, pressing the **Enter** key will create a new row directly below.

**Note:** Scroll Wrap is disabled when the Classic MMB keyboard layout is selected

**Section 8: Large Toolbar Icons**

This option allows for increasing the size of the toolbar icons so they are easier to see atop the Budgeting window.

**Note:** The Large Icons option will not display all icons if display settings for screen resolution are set to 800x600 pixels.

**Section 9: Show Grid Lines**

This option hides or reveals grid lines on a budget, depending on the preferred view. The default view in Movie Magic Budgeting 7 hides the grid lines. To show the grid lines, select **Show Grid Lines** from the **Options** drop-down menu.
Section 10: Keyboard Shortcuts

This option allows for choosing a preference of keyboard shortcuts from Movie Magic Budgeting 7 shortcuts or Classic Movie Magic keyboard shortcuts. The classic option is helpful for those familiar with the keyboard shortcuts from version 5 or below.

The default setting for the keyboard shortcuts is set to the Movie Magic Budgeting 7 version. Click on Options/Keyboard Shortcuts and choose Classic MMB to change the preference. This will not only affect some of the keyboard shortcuts, but it will also affect how the arrow keys, tab key and enter key behave.

Note: Save, close, and re-open the application for a change in keyboard shortcuts to take effect. This change will remain in place until changed again.
Section 11: Auto Complete

This option provides for the automatic completion of Globals or Units within the **Amounts, Units, X** or **Rates** columns when information is entered at the Details Level. If the application detects a Global or Unit beginning with the same alpha characters, it will auto complete that Global or Unit.

Hit the **Enter** or **Tab** key to complete the entry.

The default setting for all of the Auto Complete options is on when a new budget is started. Auto Complete can be turned off for all or individual columns by unchecking those options.
Chapter 20: Tools

Movie Magic Budgeting 7 offers tools to facilitate the budgeting process. Also on the Tools menu is access to View/Apply Fringes, View/Apply Groups, View/Exclude Contractual Charges and View/Apply Applied Credits.

Access Tools

1. Go to the Tools menu.
2. Click on a menu option.

Section 1: Calculator Tool

Movie Magic Budgeting 7 offers a calculator for calculations while budgeting. The Calculator tool opens directly on the budgeting desktop. Use a mouse to click the buttons/numbers. Operate this tool as if it were a standard calculator.

Section 2: Calendar

Movie Magic Budgeting 7 offers a calendar for date references while budgeting. The Calendar opens directly on the budgeting desktop. Click on the year or month drop-down menus to change the calendar year or month.
Section 3: View/Apply Fringes

Selecting View/Apply Fringes (CTRL + 1 / Mac: CMD + 1) from the Tools menu brings up the View/Apply Fringes window. For more information about Fringes, refer to Chapter 6: Fringes.

Section 4: View/Apply Groups

Selecting View/Apply Groups (CTRL + 2 / Mac: CMD + 2) from the Tools menu brings up the View/Apply Groups window. For more information about Groups, refer to Chapter 7: Groups.

Section 5: View/Exclude Contractual Charges

Selecting View/Exclude Contractual Charges (CTRL + ' / Mac: CMD + ') from the Tools menu brings up the View/Exclude Contractual Charges window. For more information about Contractual Charges, please refer to Chapter 3, Section 4: Contractual Charges.

Section 6: View/Apply Credit Adjustments

Selecting View/Apply Credit Adjustments from the Tools menu brings up the View/Apply Applied Credits window. For more information about Credit Adjustments, refer to Chapter 3: Section 5: Applied Credits.
Index

A

4th Level.............................................95
Access the 4th Level...............................96
Autosum.............................................97
Create a new 4th Level..............................95
Formatting...........................................102
Formatting Options.................................103
Link data with Details Level.......................98
Using 4th Level.....................................97

Accessing a Movie Magic Budget
Creating an EPB file from an MMB.............17
Opening a Movie Magic Budget..................15
Accessing a Protected Budget
Password Protection...............................145
Accounts Level....................................60
Accessing the Account Level.....................60
Entering Account Level Information.............60
Auto Complete....................................151

B

Budget Comparison
Report buttons....................................116
Vista Cost Reports..................................117
Budget Desktop Options..........................144
Accessing a Protected Budget... See Password Protection
Assigning a Password .......... See Password Protection
Auto Complete .... See Auto Complete
Autosave...........................................146
Budget Statusbar, Budget Change Password .... See Password Protection
Large Toolbar Icons ...... See Icons, Large Toolbar
Paginate............................................146
Password Protection...... See Password Protection
Read Only Permission ...... See Password Protection
Show Gridlines.............. See Gridlines
Single Document....................147
Tab Navigation.............. See Navigation
Budget Info.................................44
Access Budget Info.................44
Budget File..............................45
Budget Information....................45

Budget Number.................................45
Budget Title.....................................45
Number of Items.................................45
PDF File Conversion.............................46
Print.............................................46
Print Preview....................................46
Printing an Info Report.........................46
Remarks.........................................46
Revision Number...............................45

Budget Preferences
Aggregate Fringe % Computuation..............26
Currency.........................................28
Details Level.....................................27
Insert Detail Line.................................27
Optional Columns...............................33
Rate Column Display.............................27
Separator.........................................32
Totals............................................28

C

Calculator.........................................152
Calendar..........................................152
Compare Vista Reports.........................117
Comparing Budgets.............................115
Comparison Totals...............................42
To Show Original and Variance Columns ..........42
Update Original Column Totals..................43
Contractual Charges.............................51
Charge Types.....................................52
Delete a Group.................................55, 59
Delete a Line Item.........................55, 59
Deleting a User Entry............................55
Excluded from Contractual Charge..........53
Excluding a budget linked item..............53
Excluding a Group...............................54
Excluding a line item............................53
Include Excluded Amount in Topsheet
Description........................................56
Include Percentage in Topsheet
Description........................................56
Inserting Contractual Charges.................51
Topsheet Display and Misc. Options ..........56
User Entry..........................................53
User Manual Entry..............................53
Using Contractual Charges......................51
Create Subset.................................122

Currencies
Applying to the Entire Budget..................42
Currencies.........................................39
Adding Currencies...............................40
Applying By Individual Detail Line ........................................ 42
Applying Currencies .......................................................... 42
Deleting Currencies ................................................................ 41
Quick Pick ........................................................................... 41
Setting up Currencies ........................................................... 40

D
Details Level ....................................................................... 89
Accessing the Details Level .................................................... 89
Dedicated Detail Columns ..................................................... 93
Entering Details Level information ....................................... 90
Formula Maker ................................................................. 90
Note .................................................................................. 94
Toggle icons ...................................................................... 93

E
Entering Details Level information
Formula Maker .................................................................. 90
Exporting Budget Files ......................................................... 21
Exporting to Movie Magic ..................................................... 22

F
Find Tool
Fringe Find ...................................................................... 127
Main Functions ................................................................ 125
Replace ........................................................................... 128
Text/Numeric Finds ............................................................ 125
Text/Numeric Replace .......................................................... 128
Formula Maker .................................................................. 90
Formula Recall .................................................................... 91
Four Major Budgeting Steps .................................................. 1
Fourth Level ................................................................. See 4th Level
Fringes ........................................................................... 77
Applying Fringes .............................................................. 79
Creating Fringes .............................................................. 77
Deactivating Fringes ......................................................... 80
Displaying Fringes in the Budget ........................................ 83
Editing Fringes .................................................................. 78
Percentage Fringe, Creating ............................................... 77
Setting a Fringe Range ....................................................... 80
Setting Individual Fringe Ranges ......................................... 81
Totals ............................................................................. 78
View/Apply Fringes window buttons ..................................... 82

G
Globals .............................................................................. 61
Deleting a Global ............................................................. 75
Global Display .................................................................. 75
Setting up Globals .............................................................. 63
Gridlines ........................................................................... 149
Groups ............................................................................. 84
Adding New Groups ........................................................... 85
Applying Groups to a Budget ............................................... 86

Budget Calculation ............................................................. 86
Default status for non grouped detail lines ......................... 86
Deleting a Group ............................................................... 85
Fringe amounts in Group Totals ........................................ 86
Including or Excluding Groups .......................................... 87
Setting Up Groups ............................................................. 84
Setup Groups Window ....................................................... 84
Status if there is a Group conflict ...................................... 86

I
Icons, Large Toolbar .......................................................... 149

L
Level Breaks ...................................................................... 49
Library
Deleting Entries ................................................................. 114
Functions ....................................................................... 112
Retrieving data ................................................................. 113
Storing data .................................................................... 112
Location ........................................................................... 37
Deleting Locations ............................................................. 38
Setting up Location ........................................................... 37

M
Movie Magic ................................................................. 15
Creating an EP Budgeting file from MMB ......................... 17
Opening a Movie Magic Budget ........................................ 15

N
Navigation
Goto Account ................................................................. 4
Goto Menu ................................................................... 4
Hide Sheet options ........................................................... 3
Program ...................................................................... 2
Sheet ........................................................................ 3
Tab Navigation ................................................................. 8
Toolbar, EP Budgeting ....................................................... 2
Tools ........................................................................... 3
Window Navigation .......................................................... 5

Note
Details Level ................................................................. 94
Topsheet .................................................................... 50

O
Opening a Budget ............................................................ 14
Opening a Recently Accessed Budget ................................ 15

P
Paginate ........................................................................ 146
Password Budget Desktop Options
U

Units .................................................................34
Delete a Unit Row ........................................36
PDF File conversion ..................................36
Preset Units ................................................34
Print Preview a Units Report ..............36
Print your Units Report .......................37
Setting up a new Unit .........................35